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Safety notices

Safety notices may be printed throughout this guide.

* DANGER notices call attention to a situation that is potentially lethal or extremely hazardous to
people.

* CAUTION notices call attention to a situation that is potentially hazardous to people because of some
existing condition.

* Attention notices call attention to the possibility of damage to a program, device, system, or data.

World Trade safety information

Several countries require the safety information contained in product publications to be presented in their
national languages. If this requirement applies to your country, a safety information booklet is included
in the publications package shipped with the product. The booklet contains the safety information in
your national language with references to the U.S. English source. Before using a U.S. English publication
to install, operate, or service this product, you must first become familiar with the related safety
information in the booklet. You should also refer to the booklet any time you do not clearly understand
any safety information in the U.S. English publications.

Laser safety information

The servers can use 1/O cards or features that are fiber-optic based and that utilize lasers or LEDs.

Laser compliance

The servers may be installed inside or outside of an IT equipment rack.
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DANGER

When working on or around the system, observe the following precautions:

Electrical voltage and current from power, telephone, and communication cables are hazardous. To

avoid a shock hazard:

* Connect power to this unit only with the provided power cord. Do not use the provided power
cord for any other product.

* Do not open or service any power supply assembly.

* Do not connect or disconnect any cables or perform installation, maintenance, or reconfiguration
of this product during an electrical storm.

* The product might be equipped with multiple power cords. To remove all hazardous voltages,
disconnect all power cords.

* Connect all power cords to a properly wired and grounded electrical outlet. Ensure that the outlet
supplies proper voltage and phase rotation according to the system rating plate.

* Connect any equipment that will be attached to this product to properly wired outlets.

* When possible, use one hand only to connect or disconnect signal cables.

* Never turn on any equipment when there is evidence of fire, water, or structural damage.

* Disconnect the attached power cords, telecommunications systems, networks, and modems before
you open the device covers, unless instructed otherwise in the installation and configuration
procedures.

* Connect and disconnect cables as described in the following procedures when installing, moving,
or opening covers on this product or attached devices.

To Disconnect:

1. Turn off everything (unless instructed otherwise).
2. Remove the power cords from the outlets.

3. Remove the signal cables from the connectors.

4. Remove all cables from the devices

To Connect:

1. Turn off everything (unless instructed otherwise).
2. Attach all cables to the devices.

3. Attach the signal cables to the connectors.

4. Attach the power cords to the outlets.

5. Turn on the devices.

(D005a)

DANGER
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Observe the following precautions when working on or around your IT rack system:

* Heavy equipment-personal injury or equipment damage might result if mishandled.
* Always lower the leveling pads on the rack cabinet.

* Always install stabilizer brackets on the rack cabinet.

* To avoid hazardous conditions due to uneven mechanical loading, always install the heaviest
devices in the bottom of the rack cabinet. Always install servers and optional devices starting
from the bottom of the rack cabinet.

* Rack-mounted devices are not to be used as shelves or work spaces. Do not place objects on top
of rack-mounted devices.

* Each rack cabinet might have more than one power cord. Be sure to disconnect all power cords in
the rack cabinet when directed to disconnect power during servicing,.

* Connect all devices installed in a rack cabinet to power devices installed in the same rack
cabinet. Do not plug a power cord from a device installed in one rack cabinet into a power
device installed in a different rack cabinet.

e An electrical outlet that is not correctly wired could place hazardous voltage on the metal parts of
the system or the devices that attach to the system. It is the responsibility of the customer to
ensure that the outlet is correctly wired and grounded to prevent an electrical shock.

CAUTION

* Do not install a unit in a rack where the internal rack ambient temperatures will exceed the
manufacturer's recommended ambient temperature for all your rack-mounted devices.

* Do not install a unit in a rack where the air flow is compromised. Ensure that air flow is not
blocked or reduced on any side, front, or back of a unit used for air flow through the unit.

¢ Consideration should be given to the connection of the equipment to the supply circuit so that
overloading of the circuits does not compromise the supply wiring or overcurrent protection. To
provide the correct power connection to a rack, refer to the rating labels located on the
equipment in the rack to determine the total power requirement of the supply circuit.

e (For sliding drawers.) Do not pull out or install any drawer or feature if the rack stabilizer brackets
are not attached to the rack. Do not pull out more than one drawer at a time. The rack might
become unstable if you pull out more than one drawer at a time.

* (For fixed drawers.) This drawer is a fixed drawer and must not be moved for servicing unless
specified by the manufacturer. Attempting to move the drawer partially or completely out of the
rack might cause the rack to become unstable or cause the drawer to fall out of the rack.

(RO01)
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CAUTION:

Removing components from the upper positions in the rack cabinet improves rack stability during
relocation. Follow these general guidelines whenever you relocate a populated rack cabinet within a
room or building:

Reduce the weight of the rack cabinet by removing equipment starting at the top of the rack
cabinet. When possible, restore the rack cabinet to the configuration of the rack cabinet as you
received it. If this configuration is not known, you must observe the following precautions:

— Remove all devices in the 32U position and above.
— Ensure that the heaviest devices are installed in the bottom of the rack cabinet.

— Ensure that there are no empty U-levels between devices installed in the rack cabinet below the
32U level.

If the rack cabinet you are relocating is part of a suite of rack cabinets, detach the rack cabinet from
the suite.

Inspect the route that you plan to take to eliminate potential hazards.

Verify that the route that you choose can support the weight of the loaded rack cabinet. Refer to the
documentation that comes with your rack cabinet for the weight of a loaded rack cabinet.

Verify that all door openings are at least 760 x 230 mm (30 x 80 in.).

Ensure that all devices, shelves, drawers, doors, and cables are secure.

Ensure that the four leveling pads are raised to their highest position.

Ensure that there is no stabilizer bracket installed on the rack cabinet during movement.
Do not use a ramp inclined at more than 10 degrees.

When the rack cabinet is in the new location, complete the following steps:

— Lower the four leveling pads.

— Install stabilizer brackets on the rack cabinet.

— If you removed any devices from the rack cabinet, repopulate the rack cabinet from the lowest
position to the highest position.

If a long-distance relocation is required, restore the rack cabinet to the configuration of the rack
cabinet as you received it. Pack the rack cabinet in the original packaging material, or equivalent.
Also lower the leveling pads to raise the casters off of the pallet and bolt the rack cabinet to the
pallet.

(R002)
(L001)
'
%,
(L002)
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All lasers are certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter ] for class
1 laser products. Outside the U.S., they are certified to be in compliance with IEC 60825 as a class 1 laser
product. Consult the label on each part for laser certification numbers and approval information.

CAUTION:
This product might contain one or more of the following devices: CD-ROM drive, DVD-ROM drive,
DVD-RAM drive, or laser module, which are Class 1 laser products. Note the following information:

* Do not remove the covers. Removing the covers of the laser product could result in exposure to
hazardous laser radiation. There are no serviceable parts inside the device.

* Use of the controls or adjustments or performance of procedures other than those specified herein
might result in hazardous radiation exposure.

(C026)
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CAUTION:

Data processing environments can contain equipment transmitting on system links with laser modules
that operate at greater than Class 1 power levels. For this reason, never look into the end of an optical
fiber cable or open receptacle. (C027)

CAUTION:
This product contains a Class 1M laser. Do not view directly with optical instruments. (C028)

CAUTION:

Some laser products contain an embedded Class 3A or Class 3B laser diode. Note the following
information: laser radiation when open. Do not stare into the beam, do not view directly with optical
instruments, and avoid direct exposure to the beam. (C030)

CAUTION:
The battery contains lithium. To avoid possible explosion, do not burn or charge the battery.

Do Not:

e  Throw or immerse into water

e Heat to more than 100°C (212°F)
* ___ Repair or disassemble

Exchange only with the approved part. Recycle or discard the battery as instructed by local
regulations. (C003a)

Power and cabling information for NEBS (Network Equipment-Building System)
GR-1089-CORE

The following comments apply to the servers that have been designated as conforming to NEBS
(Network Equipment-Building System) GR-1089-CORE:

The equipment is suitable for installation in the following;:
* Network telecommunications facilities
* Locations where the NEC (National Electrical Code) applies

The intrabuilding ports of this equipment are suitable for connection to intrabuilding or unexposed
wiring or cabling only. The intrabuilding ports of this equipment must not be metallically connected to the
interfaces that connect to the OSP (outside plant) or its wiring. These interfaces are designed for use as
intrabuilding interfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE) and require isolation
from the exposed OSP cabling. The addition of primary protectors is not sufficient protection to connect
these interfaces metallically to OSP wiring.

Note: All Ethernet cables must be shielded and grounded at both ends.
The ac-powered system does not require the use of an external surge protection device (SPD).

The dc-powered system employs an isolated DC return (DC-I) design. The DC battery return terminal
shall not be connected to the chassis or frame ground.
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What's new in Installing and configuring the HMC

Read about new or significantly changed information in the Installing and configuring the HMC topic
since the previous update of this topic collection.

May 2011
+ Added information for IBM® Power Systems " servers that contain the POWER7® processor.

February 2010
¢ Added information for IBM Power Systems servers that contain the POWER? processor.
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Installing and configuring the Hardware Management Console

Describes how to install the HMC hardware, connect it to your managed system, and configure it for use.
You can perform these tasks yourself, or contact a service provider to perform these tasks for you. You
might be charged a fee by the service provider for this service.

Installation and configuration scenarios

Learn about the tasks associated with different HMC installation and configuration scenarios.

This section describes, at a high level, the tasks you must perform when you install and configure your
HMC. There are different ways you can install and configure your HMC. Find the scenario that best
matches the task you want to perform.

Note: If you are managing POWER? processor-based servers, the HMC must be at Version 7.7.1 or later.
For more information, see [“Determining your HMC machine code version and release” on page 55)

Installing and configuring a new HMC with a new server

Learn more about the high-level tasks you must perform when installing and configuring a new HMC
with a new server.

Table 1. Tasks you need to perform when installing and configuring a new HMC with a new server

Task Where to find related information

1. Gather information and complete the Preinstallation |“Preparing for HMC configuration” on page 14
Configuration Worksheet.

2. Unpack the hardware.
3. Cable the HMC hardware. [“Cabling your stand-alone HMC” on page 15

|“Cabling your rack-mounted HMC” on page 27

4. Power on the HMC by pressing the power button.

5. Log in and launch the HMC web application.

6. Access the Guided setup wizard or use the HMC “Configuring the HMC using the fast path through the|
menus to configure the HMC. Guided Setup wizard” on page 34|

“Configuring the HMC using the HMC menus” on page|

5|

7. Attach the server to the HMC.

Updating and upgrading your HMC code

Learn more about the high-level tasks you must perform when you update and upgrade your HMC code.

If you have an existing HMC and want to update or upgrade your HMC code, you must complete the
following high-level tasks:




Table 2. Tasks you need to perform when updating or upgrading HMC code

Task

Where to find related information

1. Obtain the upgrade.

2. View the existing HMC machine code level.

3. Back up the managed system’s profile data.

4. Back up HMC data.

5. Record the current HMC configuration information.

6. Record remote command status.

7. Save upgrade data.

|“Upgrading your HMC software” on page 58|

8. Upgrade the HMC software.

9. Verify that the HMC machine code upgrade installed
successfully

Migrating HMC Version 6 code to HMC Version 7 code

Learn more about the high-level tasks you must perform when you migrate from an HMC Version 6 to

an HMC Version 7.

If you have an existing HMC and want to migrate from Version 6 to Version 7, you must complete the

following high-level tasks:

Table 3. Tasks you need to perform when migrating an HMC Version 6 to an HMC Version 7

Task

Where to find related information

1. Ensure your HMC hardware supports HMC Version 7
code.

2. Ensure that your HMC code level is 6.12 or higher. If
not, you must upgrade your existing HMC code.

“Determining your HMC machine code version and|
release” on page 55|

|“Upgrading yvour HMC software” on page 58|

3. Upgrade your HMC to Version 7.

[“Upgrading your HMC software” on page 58]

4. Optional: upgrade your managed system's firmware
level to the highest available level.

2

5. If you have a second HMC, perform steps 1-4 for that
HMC.

Adding a second HMC to an existing installation

Learn more about the high-level tasks you must perform when adding a second HMC to your managed

system.

If you have an existing HMC and managed system and want to add a second HMC to this configuration,

do the following:

Table 4. Tasks you need to perform when adding a second HMC to an existing installation

Task

Where to find related information

1. Ensure your HMC hardware supports HMC Version 7
code.

2. Gather information.

3. Unpack the hardware.
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Table 4. Tasks you need to perform when adding a second HMC to an existing installation (continued)

Task Where to find related information

4. Cable the HMC hardware. |“Cabling your stand-alone HMC” on page 15|

|“Cabling your rack-mounted HMC” on page 27

5. Power on the HMC by pressing the power button.
6. Log in to the HMC.

7. The HMC code levels must match. Change the code “Determining your HMC machine code version and|
on one of the HMCs to match the code on the other. release” on page 55

|"Upgrading your HMC software” on page 58|

8. Access the Guided setup wizard or use the HMC “Configuring the HMC using the HMC menus” on page|
menus to configure the HMC. 35

9. Configure this HMC for service using the Call-Home ||”Configuring the HMC so that it can contact service and|
Setup Wizard. support” on page 47

10. Attach the server to the HMC.

HMC network connections

You can use different types of network connections to connect your HMC to managed systems. For more
information about how to configure the HMC to connect to a network, see|“Configuring the HMC” on|
For more information about using the HMC on a network, see the following:

Types of HMC network connections
Learn how to use the HMC remote management and service functions using your network.

The HMC supports the following types of logical communications:

HMC to managed system
Used to perform most of the hardware management functions, in which HMC issues control
function requests through the service processor of the managed system. The connection between
the HMC and the service processor is sometimes referred to as the service network. This
connection is required for managed system management.

HMC to logical partition
Used to collect platform-related information (hardware error events, hardware inventory) from
the operating systems running in the logical partitions, as well as to coordinate certain platform
activities (dynamic LPAR, concurrent repair) with those operating systems. If you want to use
service and error notification features, you must create this connection.

HMC to remote users
Provides remote users with access to HMC functions. Remote users can access the HMC in the
following ways:
* By using the Web browser to access all the HMC GUI functions remotely
* By using Secure Socket Shell (SSH) to access the HMC command line functions remotely
HMC to service and support
Used to transmit data, such as hardware error reports, inventory data, and microcode updates, to

and from your service provider. You can use this communications path to make automatic service
calls.

Your HMC can support up to four separate physical Ethernet interfaces, depending on the model. The

stand-alone version of the HMC supports only three HMC interfaces, using one integrated Ethernet
adapter and up to two plug-in adapters. Use each of these interfaces in the following ways:

Installing and configuring the Hardware Management Console 5



*  One or more network interfaces can be used exclusively for HMC-to-managed system
communications, which means that only the HMC and service processors of the managed systems are
on that network. Even though the network interfaces into the service processors are encrypted for the
Secure Sockets Layer (SSL) protocol and password-protected, having a separate dedicated network can
provide a higher level of security for these interfaces.

* An open network interface would typically be used for the network connection between the HMC and
the logical partitions on the managed systems, for the HMC-to-logical partition communications. You
can also use this open network interface to manage the HMC remotely.

* Optionally, you can use a third interface to connect to logical partitions and manage the HMC
remotely. This interface can also be used as a separate HMC connection to different groups of logical
partitions. For example, you might want to have an administrative LAN that is separate from the LAN
on which all the usual business transactions are running. Remote administrators could access HMCs
and other managed units using this method. Sometimes the logical partitions are in different network
security domains, perhaps behind a firewall, and you might want to have different HMC network
connections into each of those two domains.

Web browser requirements for HMC

The Hardware Management Console (HMC) is supported by Microsoft Internet Explorer (IE) version 6.0
and 7.0, Firefox version 1.5.0.7 and 2.0.

If your browser is configured to use an internet proxy, a local internet addresses should be included in
the exception list. Consult your network administrator for more information on the exception list. If you
still need to use the proxy to get to the HMC, enable Use HTTP 1.1 through proxy connections under the
Advanced tab in your Internet Options window.

Note: For Firefox version 2.0, ensure that you enable the JavaScript options to raise or lower windows
and move or resize existing windows. This feature allows you to switch easily between HMC tasks.
Perform the steps to enable the Javascript options:

1. Select Tools and Click Options

2. Select Content and Click Advanced

3. Select Move or resize existing windows and Raise or lower windows
4. Click OK

Session cookies need to be enabled in order for ASMI to work when connected to HMC remotely. The
asm proxy code saves session information and uses it. Follow the steps to enable the session cookies.

Enabling session cookies in Internet Explorer.
1. Select Tools and Click Internet Options
2. Select Privacy and Click Advanced

3. Ensure that the Always allow session cookies is checked. If not, check the Override automatic cookie
handling and check Always allow session cookies.

4. Select Prompt under First-party Cookies and Third-party Cookies
5. Click OK.

Enabling session cookies in Firefox.
1. Select Tools and click Options
2. Click Cookies

3. Select Allow sites to set cookies.
4. Select Exceptions and add HMC.
5. Click OK.
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Private and open networks in the HMC environment:

The HMC can be configured to use open and private networks. Private networks allow the use of a
selected range of nonroutable IP-addresses. A public, or "open" network describes a network connection
between the HMC to any logical partitions and to other systems on your regular network.

Private networks

The only devices on the HMC private network are the HMC itself and each of the managed systems to
which that HMC is connected. The HMC is connected to each managed system's FSP (Flexible Service
Processor).

On most systems, the FSP provides two Ethernet ports labeled HMC1 and HMC2. This allows you to
connect up to two HMCs.

Some systems have a dual-FSP option. In this scenario, the second FSP acts as a "redundant" backup. The
basic setup requirements for a system with two FSPs are essentially the same as those without a second
FSP. The HMC must be connected to each FSP, so additional network hardware is required (for example,
a LAN switch or hub) when there is more than one FSP or there are multiple managed systems.

Note: Each FSP port on the managed system must be connected to only one HMC.

Public networks

The open network can be connected to a firewall or router for connecting to the Internet. Connecting to
the Internet allows the HMC to "call home" when there are any hardware errors that need to be reported.

The HMC itself provides its own firewall on each of its network interfaces. A basic firewall is
automatically configured when you run the HMC Guided Setup wizard, but you customize your firewall
settings after the initial HMC installation and configuration.

HMC as a DHCP server:

You can use the HMC as a Dynamic Host Configuration Protocol (DHCP) server.

Note: If you are using IPv6, the discovery process must be done manually. For IPv6, there is no
automatic discovery.

For more information about how to configure the HMC as a DHCP server, see [“Configuring the HMC as|
la DHCP server” on page 42.|
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This figure shows a redundant HMC environment with two managed systems. The first HMC is
connected to the first port on each FSP, and the redundant HMC is connected to the second port on each
HMC. Each HMC is configured as a DHCP server, using a different range of IP addresses. The
connections are on separate private networks. As such, it is important to ensure that no FSP port is
connected to more than one HMC.

Each managed system's FSP port that is connected to an HMC requires a unique IP address. To ensure
that each FSP has a unique IP address, use the HMC's built-in DHCP server capability. When the FSP
detects the active network link, it issues a broadcast request to locate a DHCP server. When correctly
configured, the HMC responds to that request by allocating one of a selected range of addresses.

If you have multiple FSPs, you must have your own LAN switch or hub for the HMC to FSP private
network. Alternately, this private segment can exist as several ports in a private virtual LAN (VLAN) on a
larger managed switch. If you have multiple private VLANSs, you must ensure that they are isolated and
that there is not any crossover traffic.

If you have more than one HMC, you must also connect each HMC to the logical partitions, and to each
other, on the same open network.
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This figure shows two HMCs connected to a single managed server on the private network and to three
logical partitions on the public network. You can have an additional Ethernet adapter for the HMC to
have three network interfaces. You can use this third network as a management network or connect it to
the CSM (Cluster Systems Manager) Management Server.

For more information about how to configure the HMC as a DHCP server, see [‘Configuring the HMC as|
la DHCP server” on page 42.|

Choosing an internet protocol
Determine the IP address version used when the HMC connects to your service provider.

Most users use Internet Protocol Version 4 (IPv4) to connect to a service provider. IPv4 addresses appear
in the format representing the four bytes of the IPv4 address, separated by periods (for example,
9.60.12.123) to access the internet. You can also use Internet Protocol Version 6 (IPv6) to connect to a
service provider. IPv6 is often used by network administrators to ensure unique address space. If you are
unsure of the internet protocol used by your installation, contact your network administrator. For more
information about using each version, see|“Setting the IPv4 address” on page 42 and [‘Setting the IPv6|
laddress” on page 42

Using multiple call-home servers
This topic describes what you need to know when you decide to use more than one call-home server.

To avoid a single point of failure, configure the HMC to use multiple call-home servers. The first
available call-home server attempts to handle each service event. If the connection or transmission fails
with this call-home server, the service request is retried using the other available call-home servers until
one is successful or all have been tried.

The connected HMC that has been identified by problem analysis to be the primary analyzing console for
a given managed system will report the problem. This primary console will also replicate the problem
report to any secondary HMC. This secondary HMC must be recognized on the network by the primary
HMC. A secondary HMC is recognized by the primary HMC as an additional call-home server when:
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¢ The primary HMC is configured to use "discovered" call-home servers and the call-home server is
either on the same subnet as the primary HMC or it manages the same system

* The call-home server has been manually added to the list of call-home server consoles available for
outbound connectivity

Choosing network settings on the HMC

Learn about the network settings you can use on the HMC.

HMC network connections

You can use different types of network connections to connect your HMC to managed systems. For more
information about how to configure the HMC to connect to a network, see [‘Configuring the HMC” on|
For more information about using the HMC on a network, see the following:

Types of HMC network connections
Learn how to use the HMC remote management and service functions using your network.

The HMC supports the following types of logical communications:

HMC to managed system
Used to perform most of the hardware management functions, in which HMC issues control
function requests through the service processor of the managed system. The connection between
the HMC and the service processor is sometimes referred to as the service network. This
connection is required for managed system management.

HMC to logical partition
Used to collect platform-related information (hardware error events, hardware inventory) from
the operating systems running in the logical partitions, as well as to coordinate certain platform
activities (dynamic LPAR, concurrent repair) with those operating systems. If you want to use
service and error notification features, you must create this connection.

HMC to remote users
Provides remote users with access to HMC functions. Remote users can access the HMC in the
following ways:

* By using the Web browser to access all the HMC GUI functions remotely
* By using Secure Socket Shell (SSH) to access the HMC command line functions remotely

HMC to service and support
Used to transmit data, such as hardware error reports, inventory data, and microcode updates, to
and from your service provider. You can use this communications path to make automatic service
calls.

Your HMC can support up to four separate physical Ethernet interfaces, depending on the model. The
stand-alone version of the HMC supports only three HMC interfaces, using one integrated Ethernet
adapter and up to two plug-in adapters. Use each of these interfaces in the following ways:

* One or more network interfaces can be used exclusively for HMC-to-managed system
communications, which means that only the HMC and service processors of the managed systems are
on that network. Even though the network interfaces into the service processors are encrypted for the
Secure Sockets Layer (SSL) protocol and password-protected, having a separate dedicated network can
provide a higher level of security for these interfaces.

* An open network interface would typically be used for the network connection between the HMC and
the logical partitions on the managed systems, for the HMC-to-logical partition communications. You
can also use this open network interface to manage the HMC remotely.

* Optionally, you can use a third interface to connect to logical partitions and manage the HMC
remotely. This interface can also be used as a separate HMC connection to different groups of logical
partitions. For example, you might want to have an administrative LAN that is separate from the LAN
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on which all the usual business transactions are running. Remote administrators could access HMCs
and other managed units using this method. Sometimes the logical partitions are in different network
security domains, perhaps behind a firewall, and you might want to have different HMC network
connections into each of those two domains.

Web browser requirements for HMC

The Hardware Management Console (HMC) is supported by Microsoft Internet Explorer (IE) version 6.0
and 7.0, Firefox version 1.5.0.7 and 2.0.

If your browser is configured to use an internet proxy, a local internet addresses should be included in
the exception list. Consult your network administrator for more information on the exception list. If you
still need to use the proxy to get to the HMC, enable Use HTTP 1.1 through proxy connections under the
Advanced tab in your Internet Options window.

Note: For Firefox version 2.0, ensure that you enable the JavaScript options to raise or lower windows
and move or resize existing windows. This feature allows you to switch easily between HMC tasks.
Perform the steps to enable the Javascript options:

1. Select Tools and Click Options

2. Select Content and Click Advanced

3. Select Move or resize existing windows and Raise or lower windows
4. Click OK

Session cookies need to be enabled in order for ASMI to work when connected to HMC remotely. The
asm proxy code saves session information and uses it. Follow the steps to enable the session cookies.

Enabling session cookies in Internet Explorer.
1. Select Tools and Click Internet Options
2. Select Privacy and Click Advanced

3. Ensure that the Always allow session cookies is checked. If not, check the Override automatic cookie
handling and check Always allow session cookies.

4. Select Prompt under First-party Cookies and Third-party Cookies
5. Click OK.

Enabling session cookies in Firefox.
1. Select Tools and click Options
Click Cookies

Select Allow sites to set cookies.
Select Exceptions and add HMC.
Click OK.

o K~ e

Private and open networks in the HMC environment:

The HMC can be configured to use open and private networks. Private networks allow the use of a
selected range of nonroutable IP-addresses. A public, or "open" network describes a network connection
between the HMC to any logical partitions and to other systems on your regular network.

Private networks

The only devices on the HMC private network are the HMC itself and each of the managed systems to

which that HMC is connected. The HMC is connected to each managed system's FSP (Flexible Service
Processor).
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On most systems, the FSP provides two Ethernet ports labeled HMC1 and HMC2. This allows you to
connect up to two HMCs.

Some systems have a dual-FSP option. In this scenario, the second FSP acts as a "redundant" backup. The
basic setup requirements for a system with two FSPs are essentially the same as those without a second
FSP. The HMC must be connected to each FSP, so additional network hardware is required (for example,
a LAN switch or hub) when there is more than one FSP or there are multiple managed systems.

Note: Each FSP port on the managed system must be connected to only one HMC.

Public networks

The open network can be connected to a firewall or router for connecting to the Internet. Connecting to
the Internet allows the HMC to "call home" when there are any hardware errors that need to be reported.

The HMC itself provides its own firewall on each of its network interfaces. A basic firewall is
automatically configured when you run the HMC Guided Setup wizard, but you customize your firewall
settings after the initial HMC installation and configuration.

HMC as a DHCP server:

You can use the HMC as a Dynamic Host Configuration Protocol (DHCP) server.

Note: If you are using IPv6, the discovery process must be done manually. For IPv6, there is no
automatic discovery.

For more information about how to configure the HMC as a DHCP server, see |“Configuring the HMC as|
la DHCP server” on page 42
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This figure shows a redundant HMC environment with two managed systems. The first HMC is
connected to the first port on each FSP, and the redundant HMC is connected to the second port on each
HMC. Each HMC is configured as a DHCP server, using a different range of IP addresses. The
connections are on separate private networks. As such, it is important to ensure that no FSP port is
connected to more than one HMC.
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Each managed system's FSP port that is connected to an HMC requires a unique IP address. To ensure
that each FSP has a unique IP address, use the HMC's built-in DHCP server capability. When the FSP
detects the active network link, it issues a broadcast request to locate a DHCP server. When correctly
configured, the HMC responds to that request by allocating one of a selected range of addresses.

If you have multiple FSPs, you must have your own LAN switch or hub for the HMC to FSP private
network. Alternately, this private segment can exist as several ports in a private virtual LAN (VLAN) on a
larger managed switch. If you have multiple private VLANSs, you must ensure that they are isolated and
that there is not any crossover traffic.

If you have more than one HMC, you must also connect each HMC to the logical partitions, and to each
other, on the same open network.
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This figure shows two HMCs connected to a single managed server on the private network and to three
logical partitions on the public network. You can have an additional Ethernet adapter for the HMC to
have three network interfaces. You can use this third network as a management network or connect it to
the CSM (Cluster Systems Manager) Management Server.

For more information about how to configure the HMC as a DHCP server, see [“Configuring the HMC as|
la. DHCP server” on page 42|

Choosing an internet protocol
Determine the IP address version used when the HMC connects to your service provider.

Most users use Internet Protocol Version 4 (IPv4) to connect to a service provider. IPv4 addresses appear
in the format representing the four bytes of the IPv4 address, separated by periods (for example,
9.60.12.123) to access the internet. You can also use Internet Protocol Version 6 (IPv6) to connect to a
service provider. IPv6 is often used by network administrators to ensure unique address space. If you are
unsure of the internet protocol used by your installation, contact your network administrator. For more
information about using each version, see [“Setting the IPv4 address” on page 42| and [“Setting the IPvé|
laddress” on page 42
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Using multiple call-home servers
This topic describes what you need to know when you decide to use more than one call-home server.

To avoid a single point of failure, configure the HMC to use multiple call-home servers. The first
available call-home server attempts to handle each service event. If the connection or transmission fails
with this call-home server, the service request is retried using the other available call-home servers until
one is successful or all have been tried.

The connected HMC that has been identified by problem analysis to be the primary analyzing console for
a given managed system will report the problem. This primary console will also replicate the problem
report to any secondary HMC. This secondary HMC must be recognized on the network by the primary
HMC. A secondary HMC is recognized by the primary HMC as an additional call-home server when:

* The primary HMC is configured to use "discovered" call-home servers and the call-home server is
either on the same subnet as the primary HMC or it manages the same system

* The call-home server has been manually added to the list of call-home server consoles available for
outbound connectivity

Preparing for HMC configuration

Use this section to gather required configuration settings that you need to know before you begin the
configuration steps.

To configure the HMC, you must understand the related concepts, make decisions and prepare
information.

This section describes the information you will need to connect your HMC to the following:
* Service processors in your managed systems

* Logical partitions on those managed systems

¢ Remote workstations

* Service, to implement “call-home” functions

To prepare for HMC configuration, do the following;:
1. Obtain and install the latest level of the HMC code version you want to install.

2. Determine the physical location of the HMC in relation to the servers it will manage. If the HMC is
more than 25 feet from its managed system, you must provide web browser access to the HMC from
the managed system's location so that service personnel can access the HMC.

3. Identify the servers that the HMC will manage.

4. Determine whether you will use a private or an open network to manage servers. If you decide to
use a private network, use DHCP, unless you are using a Cluster Systems Management (CSM)
configuration. CSM does not support IPv6. To access CSM, you must have two networks. For more
information about CSM, see the documentation that was provided with that feature. For more
information about private and open networks, see|“Private and open networks in the HM{
[environment” on page 7.

5. If you will use an open network to manage an FSP, you must set the FSP's address manually
through the Advanced System Management Interface menus. A private, non-routable network is
recommended.

6. If you have two HMCs, designate a primary and secondary HMC. The primary HMC should be
physically closer to the machine, and should be the HMC that is configured to call home.

7. Determine the network settings that you will need to connect the HMC to remote workstations,
logical partitions, and network devices.
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10.

11.

12.

Define how the HMC will “call home.” Call home options include either over an outbound-only
Secure Socket Layer (SSL) Internet connection, a modem, or a Virtual Private Network (VPN)
connection.

Determine the HMC users that you will create and their passwords, as well which roles they will be
given. You must assign the hscroot and hscpe users a password.

Document the following company contact information that will be needed when configuring call
home:

* company name
* administrator contact

* email address

¢ telephone numbers

 fax numbers

* the street address of the HMC's physical location

If you plan to use email to notify operators or systems administrators when information is sent to
IBM Service through call-home, identify the Simple Mail Transfer Protocol (SMTP) server and the
email addresses you will use.

You must define the following passwords:

* The access password that will be used to authenticate the HMC to the FSP

* The ASMI password that will be used for the admin user

¢ The ASMI password that will be used for the general user

Create the passwords when you connect from the HMC to a new server for the first time. If the

HMC is a redundant or second HMC, obtain the HMC User password and be prepared to enter it
when connecting the first time to the managed server's FSP.

Setting up the HMC

You must set up the HMC hardware before you configure the HMC software. Learn more about setting
up a desk-side HMC or a rack-mounted HMC.

Cabling your stand-alone HMC

Position the HMC and cable each of the hardware components.

About this task

If an HMC is used to manage any POWER? processor-based system, the HMC must be a C05 or later
stand-alone HMC.

Procedure
1. Ensure that you position the HMC in the correct location.
2. Attach the monitor cable to the monitor connector, and tighten the screws.
3. Attach the power cord to the monitor.
4. Ensure that the voltage selection switch on the HMC is set to the voltage used in your world region.

o

The voltage selection switch is red and is located near the power connector. Move the switch so that
the voltage used at your location is displayed.

Plug the power cord into the HMC.
Connect the keyboard and mouse to the HMC.
Connect the optional modem:

Note: During the installation and configuration of the HMC, the modem might automatically dial
out as the HMC follows routine call-out procedures. This is usual behavior.
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If you are connecting an optional external modem, do the following:
a. If you have not already done so, connect the modem data cable to the external HMC modem.

b. Connect the modem data cable to the system port on the HMC that is labeled with the following
symbol:

IPHAI522-0

c. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

If you are connecting to an optional integrated modem, use the data cable to connect the integrated HMC
modem to the appropriate data source. For example, use the telephone cable to connect the HMC
modem line port to the analog jack on your wall.

8. If your managed system is already installed, you can verify that the Ethernet cable connection is
active by observing the green status lights at both the HMC and managed system Ethernet ports as
your installation progresses.

9. Connect Ethernet Connector 1 on the HMC to the LINK HMC1 port on the managed system.
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10. If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled LINK HMC?2 on the managed server.

11. If you use an external modem, plug the modem power supply cord into the HMC modem.

12. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets. If you
are connecting this HMC to a new managed system, do not connect the managed system to a power
source at this time.
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Results

Next, you will need to configure your HMC software. Continue with [“Configuring the HMC” on page|

Installing the 7310-CR4 HMC into a rack

This section describes how to install the 7310-CR4 HMC into a rack. This is a customer task.

If an HMC is used to manage any POWER? processor-based system, the HMC must be a CR3, or later,
model rack-mounted HMC.

The following is a rear-view of the 7310-CR4:
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Figure 1. Rear-view of the 7310—CR4

To install the 7310-CR4 HMC into a rack, complete the following steps:
1. Complete a parts inventory. See [Completing a parts inventoryj

2. Locate the rack-mounting hardware kit and the system rail assemblies that were included with your
system unit.

IPHAI402-0

Figure 2. Rail Kit

Table 5. Rail kit parts

Sliding-rail kit parts
A Slide rails
B Cable-management arm mounting plate

C Cable-management arm
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Table 5. Rail kit parts (continued)
Sliding-rail kit parts
D Cable-management bracket
E Cable-management support bracket and security tab
F Latch strikes (2)
G Screws (6)

Important: This system unit is 1 EIA unit high; you will need this information to complete the
installation.

Completing a parts inventory
You might need to complete a parts inventory. Use the procedure in this section to perform this task.

About this task
If you have not done so, complete a parts inventory before proceeding with the installation:

Procedure
1. Locate the kitting report in an accessory box.
2. Ensure that you received all the parts that were ordered.

Results

If there are incorrect, missing, or damaged parts, contact your reseller or sales and support.

Determining the location
You might need to determine where to install the system in the rack. This section includes procedures so
that you can perform these tasks.

About this task
Before installing the HMC into a rack, complete the following steps:

Procedure
1. Plan where you will place the units. Place the larger and heavier units in the lower part of the rack.

2. If the rack contains filler panels, remove the filler panels to allow access to the inside of the rack
enclosure where you plan to place the unit.
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Figure 3. Removing the filler panels.

3. Remove the front and back rack doors if necessary.

4. Follow the instructions for marking the location without a template, see [Marking the location without|
fa rack-mounting template|

Marking the location without a rack-mounting template:

If you need to mark the location without a template, use the procedure in this section to perform this
task.

About this task
A rack-mounting template is not included with this system. These systems are 1 EIA unit high.

To determine the mounting location, complete the following steps:
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Procedure

1.

8.
9.

Determine where in the rack to place the system. Record the EIA location.

Note: An EIA unit on your rack consists of a grouping of three holes.

Facing the front of the rack and working from the right side, place a supplied self-adhesive dot next
to the top hole of the EIA unit.

Note: The self-adhesive dots are used to aid in identifying locations on the rack. If you no longer
have any of the dots, use some other form of marking tool to aid you in identifying hole locations (for
example, tape, a marker, or pencil). If you are installing slide rails, place a mark or self-adhesive dot
on the lower and the middle hole of each EIA unit.

Place another self-adhesive dot next to the bottom hole of the above the EIA unit.

Note: If you are counting the holes, begin with the hole identified by the first dot and count up two
holes. Place the second dot next to the third hole.

Repeat step [1f for the corresponding holes located on the left side of the rack.
Go to the back of the rack.

On the right side, find the EIA unit that corresponds to the bottom EIA unit marked on the front of
the rack.

Place a self-adhesive dot at the bottom EIA unit.
Place a self-adhesive dot at the top hole of the EIA unit.
Mark the corresponding holes on the left side of the rack.

Installing the slide rails into the rack
To install slide rails into the rack, use this procedure.

About this task

To install the slide rails into the rack, complete the following steps:

Procedure

1.

20

Insert the right slide rail (A), marked right into the back-right rack mounting flange (B) locations.
The two rail pins will protrude through the bottom and middle holes (B) on the EIA unit.
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Figure 4. Installing the right slide rail into the back of the rack

2. Push on the end of the rail (A) to compress the rail's spring-loaded mechanism, and insert the rail
into the front-right rack-mounting flange (B) locations. The rail will decompress and the two rail pins
will protrude through the bottom and middle holes (B) on the EIA unit.
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Figure 5. Installing the right slide rail into the front of the rack

3. Repeat steps ~[J to install the left slide rail, marked left, into the rack.
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4. From the front of the rack, place the latch strike (C) over the pins. Finger-tighten the captive screw
(D) into the top pin in the front of the right slide rail (A).
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Figure 6. Installing the latch strike to the front of the rails

5. Repeat the previous step to install the latch strike on the front of the left slide rail.

6. Move to the rear of the rack. Finger-tighten screw (F) to attach the cable-management arm mounting
bracket (E) to the back of the left rail (G).
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Figure 7. Attaching the cable-management bracket to the back-left rail

7. If you do not plan to transport this system, continue with [“Installing the HMC on the slide rails” or|
If you plan to transport this system, insert screw (I) to attach the cable-management arm
support bracket (H) to the back-right rail (A). Finger-tighten the screw.

The cable-management arm support bracket can be used to secure the cable-management arm during
transportation. If the mechanism is engaged after the cable-management arm is installed, you will not
be able to slide the system from the rack.
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Figure 8. Attaching the cable-management support bracket to the back-right rail.
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Installing the HMC on the slide rails
You might need to install the HMC on the slide rails. Use the procedure in this section to perform this
task.

About this task

Before installing the HMC on the slide rails, ensure that the stabilizers are extended and the rack
stabilizer bracket is attached to the bottom front of the rack to prevent the rack from falling forward
when the rails are pulled out of the rack.

To install the HMC on the slide-rail assembly, complete the following steps:

Procedure

1. Remove the shipping bracket that covers the power supplies from the right rear of the HMC. To
remove the shipping bracket, push to the bracket to the right and swivel the shipping bracket off the
HMC.

2. From the front of the rack, fully extend the slide rails until the rails lock into place in the extended
position (A).

Attention: The latch strikes on the front of the rail and the cable-management arm brackets must be
installed before installing an HMC onto the rails. If these parts are not installed, the installation may
cause the rails to compress and the HMC may fall out of the rack.

IPHBF780-0

Figure 9. Extending the slide rails.

Important: This unit weighs approximately 17 kg (37 pounds). Be sure that you can safely support
this weight when placing the HMC into the rack.

3. Lift the HMC to the height of the rails, and position the set of wheels (B), at the rear of the HMC,
between the rail guides.
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Figure 10. Installing the HMC on the slide rails.

4. Push the HMC into the slide rails until the slide release catches (C) lock into place. This locks the
system in the service position on the slides. You will hear an audible click.

5. Press the front-slide rail release latches (D) on both sides of the slide rails.
6. Slide the HMC into and out of the rack to verify that the HMC moves freely without binding.

IPHBF782-0

Figure 11. Slide the HMC into the rack.

Important: Do not, under any circumstances, force the HMC into the slide rails. If the HMC does not
slide freely into the rack, completely remove the HMC from the rails. After the HMC is clear of the
rails, reposition the HMC, then reinsert the HMC into the rails. Repeat this process until the HMC
slides freely into the rack.

7. Push the HMC into place until the rack latches (F) lock into place.
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Figure 12. Rack latches and screws.

8. Completely tighten each of the four screws that were installed in the front and back of both rails.
9. If the rack will be transported, insert and tighten the two rack security screws (E).

Installing the cable-management arm
You might need to install the cable-management arm. Use the procedure in this section to perform this
task.

About this task

To install the cable-management arm, complete the following steps:

Procedure

1. From the rear of the rack, locate the cable-management arm flange (A) located on the fixed rear
portion of the left system rail assembly (viewing from the back of the rack).

2. Attach the cable-management arm clasp (B) to the rail by pushing the clasp onto the rail until it locks
into place.
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Figure 13. Cable-management arm and system unit.

3.

4.

Attach the other end of the cable-management arm (C) to the rear of the HMC. Align the tabs (D) on
the cable-management arm with the slots (E) on the rear of the HMC.

Slide the cable-management arm to the left, securing it into place. Make sure all the tabs fit into the
slots.

Push the locking lever (F) into the locked position. Ensure that the cable-management arm (C) is level
so that it moves freely.

Cabling your rack-mounted HMC
Learn how to physically install your rack-mounted HMC.

Procedure

1.
2.

Ensure that you position the HMC in the correct location.

Install the HMC into a rack. For more information, see [“Installing the 7310-CR4 HMC into a rack’|
When you are finished installing the HMC into a rack, continue with the next step.
Plug the power cord into the HMC.

Connect the keyboard, monitor, and mouse.

Connect an optional modem:

If you are connecting an external modem, do the following:

a. If you want to install the external modem into a rack, do it now.

b. If you have not already done so, connect the modem data cable to the external HMC modem.

c. Connect the modem data cable to the system port on the HMC labeled with the following
symbol:

IPHAI522-0

d. Use the telephone cable to connect the line port of the external modem to the analog telephone
jack on your wall.

e. Plug the modem power supply cord into the HMC modem.
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If you are connecting to an integrated modem, use the data cable to connect the integrated HMC modem
to the appropriate data source. For example, use the telephone cable to connect the HMC modem
line port to the analog jack on your wall.

6. Connect the Ethernet (or crossover) cable from the HMC to the managed server:
ﬁote: To learn more about the HMC network connections, see[“HMC network connections” on page|

7. If your managed system is already installed, you can verify that the Ethernet cable connection is
active by observing the green status lights at both the HMC and managed system Ethernet ports as
your installation progresses.

8. Connect the Ethernet port on the HMC to the Ethernet port that is labeled HMC1 on the managed
server.

9. If you are connecting a second HMC to your managed server, connect to the Ethernet port that is
labeled HMC2 on the managed server.

10. Plug the power cords for the monitor, HMC, and HMC external modem into electrical outlets.
Note: If you are connecting this HMC to a new managed system, do not connect the managed
system to a power source at this time.

Results

Next, you will need to configure your HMC software. Continue with [“Configuring the HMC” on page|

Installing the 7042-CR5 and 7042-CR6 into a rack
This section describes how to install the 7042-CR5 and 7042-CR6 HMC into a rack.

Before you begin

If an HMC is used to manage any POWER? processor-based system, the HMC must be a CR3, or later,
model rack-mounted HMC.

Complete a parts inventory. The following illustration shows the items that you need to install the server
in the rack cabinet. If any items are missing or damaged, contact your place of purchase.
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Note: Screws can be used for shipping, or for additional stabilization in high-vibration areas.

About this task

To install the 7042-CR5 HMC into a rack, complete the following steps:

Procedure

1. Each slide rail is marked with either an R (right) or an L (left). Select one of the slide rails and push
up on the front movable tab (1); then, pull out the front latch (2) to slide out the front side rail. If a
thumbscrew is installed in the slide rail (3), remove it.

P7HAI501-0

Figure 15. Slide rail and movable tab

Note: Make sure that the movable tab remains extended and does not click back into place.

2. Align the three pins on the rear of the slide rail with the three holes in the selected U on the rear of
the rack. Push the rails so that the pins go into the holes (1), and drop the slide rail down (2) until it

latches into place.
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Rack Rear

Figure 16. Align the pins with the holes in the rear of the rack

3. DPull the slide rail forward and insert the two pins (1) on the front of the rail into the two lower holes
in the U on the front of the rack. Drop the rail into place until it clicks into place. Push the front
latch (2) in all the way. Repeat steps 1 through 3 to install the other rail into the rack. Make sure that
each front latch is fully seated.

P7HAI503-0

Rack Front

Figure 17. Rack front rail and pins

4. Pull the slide rails forward (1) until they click, twice, into place. Carefully lift the server and tilt it
into position over the slide rails so that the rear nail heads (2) on the server line up with the rear
slots (3) on the slide rails. Slide the server down until the rear nail heads slip into the two rear slots,
and then slowly lower the front of the server (4) until the other nail heads slip into the other slots on
the slide rails. Make sure that the front latch (5) slides over the nail heads.
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Figure 18. Slide rails extended, server nail heads aligned with slots in rail

5. Lift the blue release latches (1) on the slide rails and push the server (2) all the way into the rack
until it clicks into place.

P7HAI505-0

Figure 19. Release latches and server

6. The cable-management arm can be installed on either side of the server. The following figure shows
it being installed on the left side. To install the cable-management arm on the right side, follow the
instructions and install the hardware on the opposite side. Connect one end of the support arm (1) to
the same slide rail to which you plan to attach the cable-management arm so that you can swing the
other end of the support arm (2) toward the rack.
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P7HAI506-0

Figure 20. Support arm connection

7. Install the L-shaped cable-management stop bracket (1) on the unattached end of the support arm.
Turn the bracket (2) to secure it to the support arm.

P7HAI507-0

Figure 21. Cable-management stop bracket secured to the support arm

8. To attach the other side of the support arm to the backside of the slide rail, pull the pin out (1), and
then slide the bracket (2) into the slide rail.

P7HAI508-0

Figure 22. Pin extended, bracket installed into slide rail

9. Pull out the mounting bracket pin (1) and slide the mounting bracket (2) into the slide rail onto
which you are installing the cable-management arm. Push the bracket into the slide rail until the

32 Power Systems: Installing and configuring the Hardware Management Console



spring-loaded pin snaps into place.

<
[o2]
(=3
©
<
T
~
o

Figure 23. Mounting bracket pin extended and mounting bracket installed into slide rail

10. Place the cable-management arm on the support arm. Pull out the cable-management arm pin (1),
and then slide the cable-management arm tab (2) into the slot on the inside of the slide rail. Push the
tab until it snaps into place. Pull out the other cable-management arm pin (3), and then slide that
cable management arm tab into the slot (4) on the outside of the slide rail. Push the tab until it snaps
into place.
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Figure 24. Cable-management arm connection
11. Attach the power cords and other cables to the rear of the server (including keyboard, monitor, and
mouse cables, if required). Route the cables and power cords on the cable-management arm (1) and

secure them with cable ties or hook-and-loop fasteners.

Note: Allow slack in all cables to avoid tension in the cables as the cable-management arm moves.
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Figure 25. Power cord attachment and routing

12. Slide the server into the rack until it snaps into place.

Configuring the HMC

Configure network connections, security, service applications, and some user preferences.

Depending on the level of customization you intend to apply to your HMC configuration, you have
several options for setting up your HMC to suit your needs. The Guided Setup wizard is a tool on the
HMC designed to ease the setup of the HMC. You can choose a fast path through the wizard to quickly
create the recommended HMC environment, or you can choose to fully explore the available settings that
the wizard guides you through. You can also perform the configuration steps without the aid of the
wizard by [Configuring the HMC using the HMC menus|

Before you start, gather the required configuration information that you will need to complete the steps
successfully. See [“Preparing for HMC configuration” on page 14| for a list of the required information.

Configuring the HMC using the fast path through the Guided Setup
wizard

In most cases, the HMC can be set up to operate effectively using many of the default settings. Use this
fast path checklist to prepare the HMC for service. When you have completed these steps, your HMC
will be configured as a Dynamic Host Configuration Protocol (DHCP) server in a private (directly
connected) network.

Start the HMC and complete the steps in the Guided Setup Wizard
Log in to the HMC interface and configure your HMC using the Guided Setup wizard.

Before you begin

Note: If this is a new installation, ensure that the managed system is not connected to a power source.
For rack-mounted HMCs, this means that the only device plugged into the power distribution bus (PDB)
before you plug in the main power supply is the HMC. If this is a second HMC that is connected to the
same managed system, the managed system can be connected to a power source.

Procedure
1. Turn on the HMC by pressing the power button.
2. Wait for the HMC to automatically select the default language and locale preference after 30 seconds.
3. Click Log on and launch the Hardware Management Console web application.
4. Log in to the HMC:
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Note: If your system administrator (hmcadmin) has changed the password, enter it here.
* ID: hscroot
¢ Password: abc123

The Guided Setup wizard opens.
5. Click OK on the Guided Setup entry window.

Note: If the Guided Setup wizard did not display when you started the HMC, Click Guided Setup
Wizard in the navigation area of the HMC welcome page.

6. Complete the steps in the Guided Setup wizard using the preinstallation configuration worksheet
that you completed. Click Yes to continue and complete the steps in the Connectivity and Call-Home
Servers wizard.

7. On the Summary window, click Finish.
8. If you haven't connected the Ethernet crossover cable to your managed system, do so now.
9. In the HMC navigation area, click Service Management.

10. In the contents area, click Authorize User. The Authorize User window opens.

11. Enter your ID in the field and click OK.

Review your configuration
About this task

On the Status window, monitor the progress of the different configuration settings you selected. This
window might show a status of Pending for some tasks for several minutes. Click View Log to see status
messages relating to each task. Click Close at any time to close the Guided Setup wizard. Tasks that are
still running will continue to run. Your HMC is now configured.

Results

Configuring the HMC using the HMC menus

This section provides a complete list of all HMC configuration tasks, guiding you through the process of
configuring your HMC. Choose this option if you prefer not to use the Guided Setup wizard.

You must restart your HMC for the configuration settings to take effect, so you might want to print this
checklist and keep it with you as you configure your HMC.

This information contains references to tasks that are not included in this PDF. You can access additional
support materials by referring to the Additional Resources section on the HMC Welcome page.

Prerequisites

Before you begin configuring the HMC using the HMC menus, be sure to complete the configuration
preparation activity described in [“Preparing for HMC configuration” on page 14/

Table 6. Manual HMC configuration tasks and where to find related information

Task Where to find related information

1. Start the HMC. |“Starting the HMC” on page 36|

2. Set the date and time.

3. Change predefined passwords.

4. Create additional users and return to this checklist
when you have completed this step.

5. Configure network connections. |“C0nfiguring the HMC network types” on page 37|
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Table 6. Manual HMC configuration tasks and where to find related information (continued)

Task

Where to find related information

6. If you are using an open network and a fixed IP
address, set identification information.

7. If you are using an open network and a fixed IP
address, configure a routing entry as the default gateway.

“Configuring a routing entry as the default gateway” on|

page 44_1|

8. If you are using an open network and a fixed IP
address, configure domain name services.

|“Configuring domain name services” on page 44|

9. If you are using a fixed IP address and have DNS
enabled, configure domain suffixes.

[“Configuring domain suffixes” on page 45

10. Configure your server to connect to service and
support and return to this checklist when you have
completed this step.

11. Connect the managed system to a power source.

12. Set passwords for the managed system, and each of
the ASMI passwords (general and admin)

[“Set passwords for the managed system” on page 51|

13. Access ASMI to set the date and time on the
managed system.

14. Start the managed system and return to this checklist
when you have completed this step.

15. Ensure that you have one logical partition on the
managed system.

16. Optional: add another managed system and return to
this checklist when you have completed this step.

17. Optional: If you are installing a new server with your
HMC, configure the logical partitions and install the
operating system.

18. If you are not installing a new server at this time,
perform optional postconfiguration tasks to further
customize your configuration.

|“Postconfiguration steps” on page 53|

Starting the HMC

You can long in to the HMC and choose which language you want to be displayed in the interface. Use
the default User ID hscroot and password abc123 to log on to the HMC for the first time.

About this task
To start the HMC, do the following:

Procedure

1. Turn on the HMC by pressing the power button.

2. If English is your language preference, continue with step 4.

If your language preference is a language other than English, type the number 2 when you are

prompted to change the locale.

Note: This prompt times out in 30 seconds if you do not act.

3. Select the locale that you want to display from the list in the Locale Selection window, and click OK.
The locale identifies the language that the HMC interface uses.

4. Click Log on and launch the Hardware Management Console web application.

5. Log in to the HMC using the following default user ID and password:
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ID: hscroot
Password: abc123

6. Press Enter.

Changing the date and time

The battery-operated clock keeps the date and time for the HMC. You might need to reset the console
date and time if the battery is replaced, or if you physically move your system to a different time zone.
Learn how to change the date and time for the HMC.

About this task

If you change the date and time information, the change does not affect the systems and logical partitions
that the HMC manages.

To change the date and time for the HMC, do the following:

Procedure
1. Ensure that you are a member of one of the following roles:
¢ Super administrator
 Service representative
* Operator
¢ Viewer
2. In the Navigation area, click HMC Management.

w

In the contents pane, click Change Date and Time.

4. If you select UTC in the Clock field, the time setting will adjust automatically for daylight saving
time in the time zone you select. Enter the date, time, and time zone, and click OK.

Results

Configuring the HMC network types
Configure your HMC so that it can communicate to the managed system, logical partitions, remote users,
and service and support.

Configuring HMC settings to use an open network to connect to the managed system:
Configure the HMC so that it can connect to and manage a managed system using an open network.
Before you begin

To configure the HMC network settings so that it can connect to the managed system using an open
network, do the following:

Table 7. Configuring HMC settings to use an open network to connect to the managed system

Task Where to find related information

1. Decide which interface you want to use for your
managed system. eth0 is preferred.

2. Identify the Ethernet ports for your HMC. “Identifying the Ethernet port defined as eth)” on page|

49

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed. [“Setting the media speed” on page 41|

b. Select the open network type. |“Selecting a private or open network” on page 41|
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Table 7. Configuring HMC settings to use an open network to connect to the managed system (continued)

Task

Where to find related information

c. Set static addresses.

|“Setting the IPv4 address” on page 42|

d. Set the firewall.

[“Changing HMC firewall settings” on page 43|

e. Configure the default gateway.

“Configuring a routing entry as the default gateway” on|

page 4é_l|

f. Configure DNS.

[“Configuring domain name services” on page 44|

4. Configure additional adapters, if you have them.

5. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the]
managed system” on page 52

Configuring HMC settings to use a private network to connect to the managed system:

Configure the HMC so that it can connect to and manage a managed system using a private network.

Before you begin

To configure the HMC network settings so that it can connect to the managed system using a private

network, do the following;:

Table 8. Configuring HMC settings to use a private network to connect to the managed system

Task

Where to find related information

1. Decide which interface you want to use for your
managed system.

2. Identify the Ethernet ports for your HMC.

“Identifying the Ethernet port defined as eth0” on page|
4

3. Configure the HMC as a DHCP server.

|“Configuring the HMC as a DHCP server” on page 42|

4. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the]
managed system” on page 52|

Configuring HMC settings to use an open network to connect to logical partitions:

Before you begin

To configure the HMC network settings so that it can connect to logical partitions using an open network,

do the following:

Table 9. Configuring HMC settings to use an open network to connect to logical partitions

Task

Where to find related information

1. Decide which interface you want to use for your
managed system.

2. Identify the Ethernet ports for your HMC.

“Identifying the Ethernet port defined as eth0” on page|

49

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed.

|“Setting the media speed” on page 41|

b. Select the open network type.

[“Selecting a private or open network” on page 41|

c. Set static addresses.

|“Setting the IPv4 address” on page 42|

d. Set the firewall.

[“Changing HMC firewall settings” on page 43]
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Table 9. Configuring HMC settings to use an open network to connect to logical partitions (continued)

Task

Where to find related information

e. Configure the default gateway.

“Configuring a routing entry as the default gateway” on|

[page 44_1|

f. Configure DNS.

[“Configuring domain name services” on page 44|

4. Configure additional adapters, if you have them.

5. Test the connection between the managed server and
the HMC.

“Testing the connection between the HMC and the|
managed system” on page 52|

Configuring HMC settings to use an open network to connect to remote users:

Before you begin

To configure the HMC network settings so that it can connect to remote users using an open network, do

the following:

Table 10. Configuring HMC settings to use an open network to connect to remote users

Task

Where to find related information

1. Decide which interface you want to use for your
managed system.

2. Identify the Ethernet ports for your HMC.

“Identifying the Ethernet port defined as eth0” on page|
4

3. Configure the Ethernet adapter by performing the
following tasks:

a. Set the media speed.

|“Setting the media speed” on page 41|

b. Select the open network type.

|“Selecting a private or open network” on page 41|

c. Set static addresses.

|“Setting the IPv4 address” on page 42|

d. Set the firewall.

|“Changing HMC firewall settings” on page 43|

e. Configure the default gateway.

“Configuring a routing entry as the default gateway” on|
[page 44_1|

f. Configure DNS.

|“Configuring domain name services” on page 44|

g. Configure suffixes.

[“Configuring domain suffixes” on page 45

4. Configure additional adapters, if you have them.

Configuring HMC call-home server settings:
Before you begin

To configure the HMC call-home server settings so that problems can be reported, do the following:

Table 11. Configuring HMC call-home server settings

Task

Where to find related information

1. Be sure you have all the required customer
information

2. Configure this HMC to report errors or choose an
existing call-home server to report errors

“Configuring the local console to report errors to service|
and support” on page 47|

“Choosing existing call-home servers to connect to|
service and support for this HMC” on page 50|

3. Verify that your call-home configuration is working

“Verifying that your connection to service and support is|
working” on page 50|
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Table 11. Configuring HMC call-home server settings (continued)

Task

Where to find related information

4. Authorize users to view collected system data

“ Authorizing users to view collected system data” on|

page 51

5. Schedule transmission of system data

[“Transmitting service information” on page 51

Identifying the Ethernet port defined as ethO:

Your Ethernet connection to the managed server must be made using the Ethernet port that is defined as

eth0 on your HMC.

If you have not installed any additional Ethernet adapters in the PCI slots on your HMC, the primary
integrated Ethernet port is always defined as eth0 or ethl on your HMC, if you intend to use the HMC

as a DHCP server for your managed systems.

If you have installed additional Ethernet adapters in the PCI slots, the port that is defined as eth0
depends on the location and type of Ethernet adapters you have installed.

Note: These are general rules and may not apply for all configurations.

The following table describes the rules for Ethernet placement by HMC type.

Table 12. HMC types and associated rules for Ethernet placement

HMC type

Rules for Ethernet placement

Rack-mounted HMCs with two integrated Ethernet ports

The HMC supports only one additional Ethernet adapter.

+ If an additional Ethernet adapter is installed, that port
is defined as eth0. In this case, the primary integrated
Ethernet port is then defined as ethl, and the
secondary integrated Ethernet port is defined as eth2.

e If the Ethernet adapter is a dual port Ethernet adapter
then port labeled Act/Link A will normally be etho.
The port labeled Act/1ink B would be ethl. In this
case, the primary integrated Ethernet port is then
defined as eth2, and the secondary integrated Ethernet
port is defined as eth3.

 If no adapters are installed, the primary integrated
Ethernet port is defined as etho.

Stand-alone models with a single integrated Ethernet
port

The definitions depend upon the type of Ethernet
adapter you have installed:

* If only one Ethernet adapter is installed, that adapter
is defined as eth0.

e If the Ethernet adapter is a dual port Ethernet adapter,
then the port labeled Act/1ink A will be eth@. The port
labeled Act/1ink B would be ethl. In this case, the
primary integrated Ethernet port is then defined as
eth2.

 If no adapters are installed, the integrated Ethernet
port is defined as eth0.

» If multiple Ethernet adapters have been installed, see
“Determining the interface name for an Ethernet|

adaEter.’|

Determining the interface name for an Ethernet adapter:
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If you configure the HMC as a DHCP server, that server can operate only on the network interface card
(NIC) connectors that the HMC identifies as eth® and ethl. You might also need to determine which NIC
connector you need to plug the Ethernet cable into. Learn more about determining which NIC connectors
the HMC identifies as eth® and ethl.

About this task
To determine the name the HMC has assigned to an Ethernet adapter, do the following;:

Procedure
1. Open the restricted shell terminal. Select HMC Management > Open Restricted Shell Terminal.

2. Type the following at the command line: tail -f /var/log/messages. The messages log scrolls when
new events occur.

3. Plug in your Ethernet cable. If the cable was already plugged in, then unplug it, wait 5 seconds, and
plug in the cable again. The restricted shell scrolls to display a message when you plug-in the cable.
The following example entry shows that this Ethernet port is identified as eth0: Aug 28 12:41:20
termite kernel: el000: ethO: el000 watchdog: NIC Link is Up 100.

4. Repeat this procedure for all other Ethernet ports, and record your results.
5. Type Ctrl+C to stop the tail command.

Setting the media speed:
Learn how to specify the media speed and duplex mode of the Ethernet adapter.
Before you begin

The default for the adapter settings is Autodetection. If this adapter is connected to a LAN switch, you
must configure the required settings manually. To set the media speed, complete the following steps:

Procedure

In the Navigation area, click HMC Management.

Click Change network settings.

Click the LAN Adapters tab.

Select the LAN adapter you want to work with and click Details.

In the Local area network information section, select the media speed.
Click OK.

o o~ N~

Selecting a private or open network:

A private service network consists of the HMC and the managed systems. A private service network is
restricted to consoles and the systems they manage, and is separate from your company network. An
open network consists of your private service network and your company network. An open network
might contain network endpoints in addition to consoles and managed systems, and might span across
multiple subnets and network devices.

About this task
To select a private or public network, do the following:

Procedure

1. In the Navigation area, click HMC Management.
2. Click Change network settings.

3. Click the LAN Adapters tab.
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Select the LAN adapter that you want to work with and click Details.
Click the Lan Adapter tab.

In the Local area network information page, select Private or Open.
Click OK.

N oo~

Configuring the HMC as a DHCP server:

Dynamic Host Configuration Protocol (DHCP) provides an automated method for dynamic client
configuration.

To configure the HMC as a DHCP server, do the following:
1. In the Navigation area, click HMC Management.
2. In the Work area, click Change network settings. The Customize Network Settings window opens.

3. Select the LAN adapter that you want to work with and click Details.
4. Select Private and then select the network type.
5. In the DHCP Server section, check Enable DHCP Server to enable the HMC as a DHCP server.

Note: You can configure the HMC to be a DHCP server only on a private network. If you use an
open network, the you do not have the option to check the Enable DHCP box.

6. Enter the address range of the DHCP server.

7. Click OK.

If you configured your HMC to be a DHCP server on a private network, you must verify that your HMC
DHCP private network is configured correctly. For information about connecting your HMC to a private
network, see [“Selecting a private or open network” on page 41

For more information, see ["HMC as a DHCP server” on page 7

Setting the IPv4 address:
Learn how to set your IPv4 address on the HMC.

Procedure

In the Navigation area, click HMC Management.

Click Change network settings.

Click the LAN Adapters tab.

Select the LAN adapter that you want to work with and click Details.
Click the Basic Settings tab.

Select an IPv4 address.

If you selected to specify an IP address, enter the TCP/IP interface address and the TCP/IP interface
network mask.

8. Click OK.
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Setting the IPv6 address:
Learn how to set your IPv6 address on the HMC.

Procedure

1. In the Navigation area, click HMC Management.
2. Click Change network settings.

3. Click the LAN Adapters tab.
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Select the LAN adapter that you want to work with and click Details.

Click the IPv6 Settings tab.

Select an Autoconfig option or add a static IP address.

If you added an IP address, enter the IPv6 address and the prefix length and click OK.
Click OK.
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Using only IPv6 addresses:
Learn how to configure the HMC so that it uses only IPv6 addresses.

Procedure

In the Navigation area, click HMC Management.

Click Change network settings.

Click the LAN Adapters tab.

Select the LAN adapter that you want to work with and click Details.

Select No IPv4 address.

Click the IPv6 Settings tab.

Select Use DHCPv6 to configure IP settings or add static IP addresses. Then click OK.
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What to do next

After you click OK, you must reboot your HMC for these changes to take effect.

Changing HMC firewall settings

In an open network, a firewall is used to control outside access to your company network. The HMC also

has a firewall on each of its Ethernet adapters. To control the HMC remotely or give remote access to
others, modify the firewall settings of the Ethernet adapter on the HMC that is connected to your open
network.

About this task
To configure a firewall, use the following steps:

Procedure

In the Navigation area, click HMC Management.

Click Change network settings.

Click the LAN Adapters tab.

Select the LAN adapter that you want to work with and click Details.
Click the Firewall tab.

Using one of the following methods, you can allow any IP address using a particular applications
through the firewall, or you can specify one or more IP addresses:
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* Allow any IP address using a particular application through the firewall:
a. From the top box, highlight the application.

b. Click Allow Incoming. The application displays in the bottom box to signify that it has been
selected.

* Specify which IP addresses to allow through the firewall:
a. From the top box, highlight an application.
b. Click Allow Incoming by IP Address.
¢c. On the Hosts Allowed window, enter the IP address and the network mask.
d. Click Add and click OK.
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7. Click OK.

Enabling remote restricted shell access:

You can enable remote restricted shell access when configuring a firewall.
About this task

To enable remote restricted shell access, do the following:

Procedure

1. In the Navigation area, click HMC Management.

2. Click Remote Command Execution.

3. Select Enable remote command execution using the ssh facility and then click OK.

What to do next

Now remote restricted shell access is enabled.
Enabling remote Web access:

You can enable remote web access to your HMC.
About this task

To enable remote web access, do the following:

Procedure

1. In the Navigation area, click HMC Management.
2. Click Remote Operation.

3. Select Enable and then click OK.

What to do next

Now remote web access is enabled.

Configuring a routing entry as the default gateway
Learn how to configure a routing entry as the default gateway. This task is available for those using an
open network.

Before you begin
To configure a routing entry as the default gateway, do the following:

Procedure

1. In the Navigation area, click HMC Management.

2. In the Work area, click Change network settings. The Customize Network Settings window opens.
3. Click the Routing tab.
4

. In the Default gateway information section, enter the gateway address and gateway device of the
routing entry you want to set as the default gateway.

5. Click OK.

Configuring domain name services
If you plan to set up an open network, configure domain name services.
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About this task

If you plan to set up an open network, configure domain name services. Domain Name System (DNS) is
a distributed database system for managing host names and their associated Internet Protocol (IP)
addresses. Configuring domain name services includes enabling DNS and specifying the domain suffix
search order.

Procedure
1. In the Navigation area, click HMC Management.

2. In the work area, click Change network settings. The Change Network Settings window opens.
3. Click the Name Services tab.

4. Check DNS enabled to enable DNS.

5. Specify the DNS server and domain suffix search order and click Add.

6. Click OK.

Configuring domain suffixes
The list of domain suffixes is used to resolve an IP address starting with the first entry in the list.

About this task

The domain suffix is a string appended to a host name that is used to help resolve its IP address. For
example, a host name of myname might not be resolved. However, if the string myloc.mycompany.com is an
element in the domain suffix table, then there will be an attempt to resolve myname.mloc.mycompany .com
also.

To configure a domain suffix entry, use these steps:

Procedure

1. In the Navigation area, click HMC Management.

In the work area, click Change network settings. The Customize Network Settings window opens.
Click the Name Services tab.

Enter a string to be used as a domain suffix entry.

5. Click Add to add it to the list.
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Configuring the HMC so that it uses LDAP remote authentication
You can configure your HMC so that it uses LDAP (Lightweight Directory Access Protocol) remote
authentication.

Before you begin

When a user logs in to the HMC, authentication is first performed against a local password file. If a local
password file is not found, the HMC can contact a remote LDAP server for authentication. You must
configure your HMC so that it uses LDAP remote authentication.

Note: Before you configure the HMC so that it uses LDAP authentication, you must ensure that a
working network connection exists between the HMC and the LDAP servers. For more information about
configuring HMC network connections, see [‘Configuring the HMC network types” on page 37/

About this task

To configure your HMC so that it uses LDAP authentication, do the following:
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Procedure
1. In the Navigation area, click HMC Management.
2. In the Contents area, click LDAP Configuration. The LDAP Server Definition window opens.

3. Select Enable LDAP.

4. Define an LDAP server to use for authentication.

5. Define the LDAP attribute used to identify the user being authenticated. The default is uid, but you
can use your own attributes.

6. Define the distinguished name tree, also known as the search base, for the LDAP server.

7. Click OK.

8. If a user wants to use LDAP authentication, the user must configure his profile so that it uses LDAP
remote authentication instead of local authentication.

Configuring the HMC so that it uses Key Distribution Center servers for Kerberos
remote authentication

You can configure the HMC so that it uses Key Distribution Center (KDC) servers for Kerberos remote
authentication.

Before you begin

When a user logs in to the HMC, authentication is first performed against a local password file. If a local
password file is not found, the HMC can contact a remote Kerberos server for authentication. You must
configure your HMC so that it uses Kerberos remote authentication.

Note: Before you configure the HMC so that it uses KDC servers for Kerberos remote authentication, you
must ensure that a working network connection exists between the HMC and the KDC servers. For more
information about configuring HMC network connections, see |[’Configuring the HMC network types” on|
-ae 37.

About this task

To configure the HMC so that it uses KDC servers for Kerberos remote authentication, do the following:

Procedure

1. Enable the Network Time Protocol (NTP) service on the HMC and set the HMC and the KDC servers
to synchronize time with the same NTP server. To enable the NTP service on the HMC, do the

following:

a. In the navigation area, select HMC Management.
b. In the contents area, select Change Date and Time.
C. Select the NTP Configuration tab.

d. Select Enable NTP service on this HMC.

e. Click OK.

2. Configure each remote HMC user's profile so that it uses Kerberos remote authentication instead of
local authentication.

3. Optional: you can import a service-key file into this HMC. The service-key file contains the host
principal that identifies the HMC to the KDC server. Service-key files are also known as keytabs. To
import a service-key file into this HMC, do the following:

a. In the navigation area, select HMC Management.

b. In the contents area, select Configure KDC. The Key Distribution Center Configuration window
opens.

C. Select Actions > Import Service Key .... The Import Service Key window opens.
d. Type the location of the service key file.
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e. Click OK.
4. Add a new KDC server to this HMC. To add a new KDC server to this HMC, do the following:
a. In the navigation area, select HMC Management.

b. In the contents area, select Configure KDC. The Key Distribution Center Configuration window
opens.

C. Select Actions > Add KDC Server .... The Import Service Key window opens.
d. Type the realm and the host name or IP address of the KDC server.
e. Click OK.

Configuring the HMC so that it can contact service and support
Configure your HMC so that it can notify you when problems occur.

Configuring the HMC so that it can connect to service and support using the call-home setup wizard:
Configure the HMC so that it is a call-home server using the call-home wizard.
Before you begin

This procedure describes how to configure the HMC as a call-home server using direct (LAN-based) and
indirect (SSL) connections to the Internet.

Before you begin this task, ensure that:

* The network administrator has verified that connectivity is allowed. For more information, see
[“Preparing for HMC configuration” on page 14|

* If you are configuring internet support through a proxy server, you must also have the following:
— The IP address and port of the proxy server
— The proxy authentication information

¢ The adapter designated as ethl (the one that is designated as an open network) is used. For more
information, see [“Choosing network settings on the HMC” on page 10|

* An Ethernet cable physically connects the HMC to the LAN.

To configure the HMC so that it is a call-home server using the call-home wizard, do the following;:

Procedure
1. In the navigation area, select Service Management.

2. In the contents area, select Call-Home Setup Wizard. The Connectivity and Call-Home Servers wizard
opens. Follow the instructions in the wizard to configure call-home.

Configuring the local console to report errors to service and support:

Configure this HMC so that it can call-home errors using LAN connectivity, the phone or modems, or
VPN.

Configuring an HMC to contact service and support using LAN-based Internet and SSL:

Describes how to configure the HMC as a call-home server using direct (LAN-based) and indirect (SSL)
connections to the Internet.

Before you begin

Before you begin this task, ensure that:

¢ The network administrator has verified that connectivity is allowed. For more information, see
[“Preparing for HMC configuration” on page 14
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* Customer contact information has been configured. Verify this by going to the HMC interface and
clicking Service Management > Manage Customer Information.

* If you are configuring internet support through a proxy server, you must also have the following:
— The IP address and port of the proxy server
— The proxy authentication information

* You need at least one open network interface configured. For more information, see [“Private and open|
inetworks in the HMC environment” on page 7/

* An Ethernet cable physically connects the HMC to the LAN.

About this task
To configure the HMC as a Call-home server using LAN-based Internet and SSL, do the following:

Procedure
1. In the Navigation area, click Service Management.

2. In the Connectivity section, click Manage Outbound Connectivity. The Call-home Server Consoles
window opens.

Click Configure...

In the Outbound Connectivity Settings window, check Enable local system as call-home server.
Accept the agreement.

In the Outbound Connectivity Settings window, select the Internet tab.

Check the Allow an existing internet connections for service box.

If you are using an SSL proxy, check the Use SSL proxy box.
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If you are using an SSL proxy, fill in the proxy's address and port. Obtain this information from the
network administrator.

10. If you checked Use SSL proxy and the proxy requires user ID and password authentication, check
the Authenticate with the SSL proxy box. Type the userid and password. Obtain the user ID and
password from the network administrator.

11. Select the Protocol to Internet you want to use.

12.  On the Internet tab, click Test....

13. In the Test Internet window, click Start.

14. Verify that the test completes successfully.

15. In the Test Internet window, click Cancel.

16. In the Outbound Connectivity Settings window, click OK.

Connecting to service and support using the telephone and modems:
Describes how to configure the HMC as a call-home server using modem access to support.
Before you begin

Before you begin this task, ensure that:
* You have an dedicated analog telephone line available.

* You have the information required to configure the modem. For more information, see
[HMC configuration” on page 14

¢ Customer contact information has been configured. You may verify this by going to the HMC interface
and clicking Service Management > Manage Customer Information.

* Ensure you have the following information available:
— The type of analog line; that is, tone or pulse. Most lines are tone, but some are in use that are the
older rotary or pulse type.
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— Whether the line presents a dial tone when the telephone is picked up. Most telephones do, but

some are in use that do not.

— Whether a dial prefix string is required. A dial prefix string is a number or series of numbers that

allow access to an outside line.

About this task

To configure the HMC as a call-home server using modem access to support, do the following:

Procedure

1.

11.
12.
13.
14.
15.
16.
17.
18.
19.

20.
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In the Navigation area, click Service Management.

In the Connectivity section, click Manage Outbound Connectivity.

Click Configure...

In the Outbound Connectivity Settings window, check Enable local system as call-home server.
Accept the agreement.

In the Outbound Connectivity Settings window, select the Local Modem tab.

In the Local Modem tab, check the Allow local modem dial for service box.

In the Local Modem tab, check the Modem Configuration box.

In the Customize Modem Settings window, click Dial type, Tone or Pulse. If the line presents a dial
tone when the receiver is taken off the hook, check the Wait for dial tone box. Fill in any dial prefix
string that is required to obtain an outside line.

Click OK.

In the Local Modem tab, click Add.

Select a number from the list.

If this is a local number, remove the area code from the Telephone number field.
In the Add Telephone Number panel, click Add.

In the In the Customize Modem Settings panel, click Test.

In the Test Telephone Number panel, click Start.

Verify that the test completes successfully.

In the Test Telephone Number window, click Cancel.

You can configure up to five telephone numbers. Configure at least two telephone numbers (a
primary and a backup). The numbers will be attempted in the order that they are configured. To add
additional numbers to the callable list, repeat the steps in this procedure.

In the Outbound Connectivity Settings window, click OK.

Connecting to service and support using a LAN-based VPN:

Configure the call-home server using VPN.

Before you begin

Before you begin this task, ensure that:

* The network administrator has verified that connectivity is allowed. For more information, see

[‘Preparing for HMC configuration” on page 14|

The adapter designated as ethl (the one that is designated as an open network) is used. For more

information, see [“Choosing network settings on the HMC” on page 10

An Ethernet cable physically connects the HMC to the LAN.

Customer contact information has been configured. Verify this situation by clicking Service
Management > Manage Customer Information on the HMC interface.
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To configure the call-home server using VPN, do the following:

Procedure
1. In the Navigation area, click Service Management.
2. In the Connectivity section, click Manage Outbound Connectivity.
Click Configure...
In the Outbound Connectivity Settings window, check Enable local system as call-home server.
Accept the agreement.
In the Outbound Connectivity Settings window, click the Internet VPN tab.
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In the Internet VPN tab, check the Allow A VPN and an existing internet connections for service
box.

8. In the Internet VPN tab, click Test.
9. In the Test Internet VPN window, click Start.
10. Verify that the test completes successfully.
11. In the Test Internet VPN window, click Cancel.
12. In the Outbound Connectivity Settings window, click OK.

Choosing existing call-home servers to connect to service and support for this HMC:

Choose existing HMC call-home servers that have been recognized, or "discovered" by this HMC to
report errors.

Before you begin

Discovered HMCs are HMCs that are enabled as call-home servers and are either on the same subnet or
manage the same managed system as this HMC.

To choose a discovered HMC to call home when this HMC reports errors, do the following;:

Procedure
1. In the navigation area, click Service Management.

2. In the contents area, click Manage Outbound Connectivity. The Call-Home Server Consoles window
opens.

3. Click the Use discovered call-home server consoles box. The HMC displays the IP address or host
name of the HMCs configured for call-home.

4. Click OK.
Results

You can also manually add existing HMC call-home servers that are on a different subnet. Select the IP
address or host name of the HMC that is configured for call home and click Add.... Then click OK.

Verifying that your connection to service and support is working:
Test problem reporting to ensure that connection to service and support is working.
About this task

To verify that your call-home configuration is working, do the following:

50 Power Systems: Installing and configuring the Hardware Management Console



Procedure

In the Navigation area, click Service Management.

In the Work area, click Create Event.

Check Test Automatic problem Reporting and type a comment.

Click Request Service. Wait a few minutes for the request to be sent.

In the Service Management window, select Manage Events.

Select All open problems.

Verify that there is a PMH event and number assigned to the problem number you opened.
Check that event and select Close.

On the Close window, type your name and a brief comment.
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Authorizing users to view collected system data:

You must authorize users to view data about your systems.

About this task

To authorize users to view collected system data, do the following:

Procedure

1. In the navigation area, select Service Management.
2. In the contents area, select Authorize User.

3. Enter your ID.

4. Click OK.

Transmitting service information:

You can transmit information to your service provider immediately, or you can schedule the information
to be sent on a regular basis.

Before you begin

Note: You should transmit service provider information as soon as the HMC is installed and configured
for use.

About this task
To transmit service information, do the following;:

Procedure

1. In the navigation area, click Service Management.

2. In the contents area, click Transmit Service Information.

3. Complete the tasks in the Transmit Service Information window, and click OK.

Set passwords for the managed system
You must set passwords for both your server and Advanced System Management (ASM). Read more
about how to use the HMC interface to set these passwords.

Before you begin

If you received the message Authentication Pending, the HMC prompts you to set the passwords for the
managed system.
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About this task

If you did not receive the message Authentication Pending, complete the following steps to set the
passwords for the managed system.

Update your server password:
Before you begin

To update your server password, do the following:

Procedure

1. In the Navigation area, select the managed system.

2. In the Tasks area, click Operations.

3. Click Change Password. The Update Password window opens.
4. Type the required information and click OK.

Update your Advanced System Management (ASM) general password:
Before you begin

Note: The default password for the general user ID is general, and the default password for the
administrator ID is admin.

To update your ASM general password, do the following:

Procedure

1. In the Navigation area of the HMC, select the managed system.

2. In the Tasks area, click Operations.

3. Click Advanced System Management (ASM). The Launch ASM Interface window opens.
4. Select a Service Processor IP Address and click OK. The ASM interface opens.

5. On the ASMI Welcome pane, specify your user 1D and password, and click Log In.

6. In the Navigation area, expand Login Profile.

7. Select Change Password.

8. Specify the required information, and click Continue.

Reset the Advanced System Management (ASM) administrator password:
Before you begin

To reset the administrator password, contact an authorized service provider.

Testing the connection between the HMC and the managed system
This option enables you to verify that you are properly connected to the network.

About this task

To test network connectivity, you must be a member of one of the following roles:
* super administrator

* service representative

To test the connection between the HMC and the managed system, do the following:
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Procedure
1. In the Navigation area, click HMC Management.
2. Click Test Network Connectivity.

3. In the Ping tab, type the host name or IP address of any system to which you want to connect. To test
an open network, type the gateway. Click Ping.

Results
If you have not yet created any logical partitions, you will not be able to ping the addresses. You can use

the HMC to create logical partitions on your server. To view the PDF file of Logical partitioning,
approximately 1 MB in size, see |../p7hat/oemp7hat.pdf|

To understand how the HMC can be used in a network, see [“HMC network connections” on page 5/

For more information about configuring the HMC to connect to a network, see [“Configuring the HM({]
fusing the HMC menus” on page 35.

Postconfiguration steps
After you have installed and configured the HMC, back up HMC data as necessary.

Backing up critical HMCdata

You can back up important console information to a USB Flash Memory Device, DVD, via FTP, or over
the network.

About this task

Using the HMC, you can back up all important data, such as the following:
 User-preference files

* User information

¢ HMC platform-configuration files

* HMC log files

* HMC updates through Install Corrective Service

The Backup function saves the HMC data stored on the HMC hard disk to the following:
* DVD media

* USB Flash Memory Device

* Remote system mounted to the HMC file system (such as NFS)

* Remote site through FTP

Back up the HMC after you have made changes to the HMC or to the information associated with logical
partitions.

Note: Before data can be saved to removable media, the media must be formatted. To format media, click
HMC Management > Format Media and follow the steps.

To back up the HMC, you must be a member of one of the following roles:
 super administrator
* operator

* service representative

To back up the HMC critical data, do the following:
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Procedure
1. In the Navigation area, click HMC Management.
2. Select Back up HMC Data.

3. Select an archive option. You can back up to media on the local system, back up to a mounted remote
system, or send backup data to a remote site.

4. Follow the instructions on the window to back up the data.

Backing up the entire HMC hard drive to a remote system
You can use your HMC to back up the entire hard disk of your HMC to a remote system.

Before you begin

Your remote system must have Network File System (NFS) or Secure Shell (ssh) configured, and this
network must be accessible from the HMC. To complete this task, you must shut down and reboot the
HMC. Use only the HMC to perform these tasks.

About this task

To back up the HMC hard drive to a remote system, you must be a member of one of the following roles:
* super administrator
* operator

* service representative
To back up the HMC hard drive to a remote system, do the following:

Procedure

1. Record the interface number (i.e. eth0, ethl, etc), MAC address and IP address of each of the
network adapters on the HMC. To do this, click HMC Management > Change Network Settings >
LAN Adapters.

. Shut down and power off the HMC.

. Power on the HMC console with the HMC recovery media in the DVD drive. If you want to start
the HMC interface from a configured network boot server, make sure the network interface is one of
the devices in your startup sequence. To view the list of startup devices, press F12 when the HMC
powers on, and select the network interface from which you want to boot.
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Select the backup option and click Next.

o

Select the network interface to use for communicating with the remote server. If you are starting the
HMC by contacting a network boot server, and this server is also the remote server to which you
want to back up the data, then select the default settings. Then click Next and go to step 7. If you do
not select the default settings, continue with the next step.

Note: The interface numbering (ethO, ethl) may not match the numbering recorded in Step 1. The
MAC address listed can be used to identify the desired interface. For more information, see
[“Identifying the Ethernet port defined as eth0” on page 40

12

If you do not select the Default settings, you must select the network protocol to use with the
selected interface. You can choose to obtain an IP address from a DHCP server in your network or
assign a static IP address to the selected network interface. Make your selection and click Next.

N

If you did not select the default settings, type the IP address or host name of your remote server.
The backup file will be created using the gzip compression utility and the tar command. Specify a
file with the .tgz extension in the File on remote host field. If you have selected the default network
settings, you must use the directory setup in your network boot configuration. This information is
displayed in the File on remote host field. After you have completed all the required information,
click Next.
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8. Select the method you want to use to transfer the data from your HMC to the remote server. If you
choose to encrypt the data, your remote host must have Secure Shell (SSH) server running. If you
choose to transfer the data without encryption, your remote host must have Network File Server
(NFS) running, and the directory to which you want to back up data must be exported for write
access. Make your selection and click Next.

9. If you select to transfer the data using encryption, you must type the remote server's user ID and
password.

10. Verify the information you entered is correct and click Finish. When the backup completes, the HMC
interface is displayed.

What to do next

If you have modified the startup sequence by pressing F1 when you powered on the HMC, you must
reboot the HMC and change the settings again. When you change the startup sequence, ensure that your
hard disk is listed in the startup sequence before the network interface.

Updating, upgrading, and migrating your HMC machine code

Updates and upgrades are periodically released for the HMC to add new functionality and to improve
existing features. Learn more about the differences between updating, upgrading, and migrating your
HMC machine code. Also learn how to perform an HMC machine code update, upgrade, or migration.

When you are finished with each of these tasks, the HMC reboots but the partitions do not.

Updating HMC code
Applies maintenance to an existing HMC level

Does not require that you perform the Save upgrade data task

Upgrading HMC code
Replaces HMC software with a new release or fix level of the same program

Requires that you boot from recovery media

Migrating HMC code
Moves HMC data from one HMC version to another

A migration is a type of upgrade.

Determining your HMC machine code version and release

Find out how to view the HMC machine code version and release.
About this task

The level of machine code on the HMC will determine the available features, including concurrent server
firmware maintenance and enhancements to upgrading to a new release.

To view the HMC machine code version and release, do the following:

Procedure
1. In the Navigation area, click Updates.

2. In the Work area, view and record the information that appears under the HMC Code Level heading,
including: the HMC version, release, maintenance level, build level, and base versions.

Obtaining and applying machine code updates for the HMC with an
Internet connection

Learn how to obtain machine code updates for the HMC when the HMC has an Internet connection.
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About this task

To obtain machine code updates for the HMC, perform steps 1 through 5.

Step 1. Ensure that you have an Internet connection
About this task

To download updates from the service and support system or website to your HMC or server, you must
have one of the following:

* SSL connectivity with or without a SSL proxy
* Internet VPN

To ensure that you have an Internet connection, do the following;:

Procedure
1. In the Navigation area, click Service Management.
2. Select Manage Outbound Connectivity.

3. Select the tab for the type of outbound connectivity that you chose for your HMC (Internet VPN or
SSL connectivity).

Note: If a connection to service and support does not exist, set up the service connection before
proceeding with this procedure. For instructions on how to set up a connection to service and
support, see Setting up your server to connect to service and support.

4. Click Test.

5. Verify that the test completes successfully. If the test is not successful, troubleshoot your connectivity
and correct the problem before proceeding with this procedure. Alternatively, you can obtain the
update on DVD.

6. Continue with [‘Step 2. View the existing HMC machine code level.”|

Step 2. View the existing HMC machine code level
About this task

To view the existing HMC machine code level, do the following:

Procedure
1. In the Navigation area, click Updates.

2. In the Work area, view and record the information that appears under the HMC Code Level heading,
including the HMC version, release, maintenance level, build level, and base versions.

3. Continue with [’Step 3. View the available HMC machine code levels.”|

Step 3. View the available HMC machine code levels
About this task

To view the available HMC machine code levels, do the following:

To find out if there are new HMC machine code updates available, contact service and support.

Step 4. Apply the HMC machine code update
About this task

To apply the HMC machine code update, do the following:
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Procedure

1. Before you install updates to the HMC machine code, back up critical console information on your
HMC. For instructions, see [‘Backing up critical HMCdata” on page 53.| Then continue with the next
step.

In the Navigation area, click Updates.

Click Update HMC. The Install Corrective Service Wizard opens.

Follow the instructions in the Wizard to install the update.

Shut down and then restart the HMC for the update to take effect.

Click Log on and launch the Hardware Management Console web application.
7. Log in to the HMC interface.

2 A

Step 5. Verify that the HMC machine code update installed successfully
About this task

To verify that the HMC machine code update installed correctly, do the following:

Procedure
1. In the Navigation area, click Updates.

2. In the Work area, the HMC version, release, maintenance level, build level, and base versions are
displayed under the HMC Code Level heading.

3. Verity that the version and release match the update that you installed.

4. If the level of code displayed is not the level that you installed, perform the following steps:
a. Check the network connection on the HMC.
b. Retry the firmware update using a different repository.
c. If the problem persists, contact your next level of support.

Obtaining and applying machine code updates for the HMC using DVD
or an FTP server

Learn how to obtain machine code updates for the HMC using DVD or an FIP server.
About this task

To obtain HMC machine code updates, perform steps 1 through 5.

Step 1. View the existing HMC machine code level
Before you begin

To view the existing HMC machine code level, do the following:

Procedure
1. In the Navigation area, click Updates.

2. In the Work area, view and record the information that appears under the HMC Code Level heading,
including the HMC version, release, maintenance level, build level, and base versions.

3. Continue with [“Step 2. View the available HMC machine code levels.”|

Step 2. View the available HMC machine code levels
Before you begin

To view the available HMC machine code levels, do the following;:
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About this task

To find out if there are new HMC machine code updates available, contact service and support.

Step 3. Obtain the HMC machine code update
Before you begin

To obtain the HMC machine code update, do the following:
About this task
To order the HMC machine code update on removable media, contact service and support.

What to do next

When you are finished, continue with [‘Step 4. Apply the HMC machine code update.”|

Step 4. Apply the HMC machine code update
Before you begin

To apply the HMC machine code update, do the following:

Procedure

1. Before you install updates to the HMC machine code, back up HMC data. For more information, see
[‘Backing up critical HMCdata” on page 53]

2. If you obtained or created the update on DVD-RAM, insert it into the DVD drive on the HMC. If you
obtained or created the update on a USB memory device, insert the memory device.

In the Navigation area, click Updates.

Click Update HMC. The Install HMC Corrective Service Wizard opens.

Follow the instructions in the Wizard to install the update.

Shut down, restart, and log back in to the HMC for the update to take effect.

7. Continue with [’Step 5. Verify that the HMC machine code update installed successfully.”|
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Step 5. Verify that the HMC machine code update installed successfully
Before you begin

To verify that the HMC machine code update installed successfully, do the following:

Procedure

1. In the Navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,
build level, and base versions are displayed under the HMC Code Level heading.

2. Verify that the version and release match the update that you installed.

3. If the level of code displayed is not the level that you installed, perform the following steps:
a. Retry the machine code update. If you created a DVD for this procedure, use a new media.
b. If the problem persists, contact your next level of support.

Upgrading your HMC software

Learn how to upgrade the software on an HMC from one release to the next while maintaining your
HMC configuration data.

About this task

To upgrade machine code on an HMC, perform steps 1 through 9.
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Note: If you are upgrading from HMC with Version 6 with HMC Version 7, refer to

fmachine code on an HMC from Version 6 to Version 7” on page 62.|

Step 1. Obtain the upgrade
About this task

To order the HMC machine code upgrade on DVD-RAM, contact service and support.

To obtain the upgrade through the Fix Central website, do the following:

Step 2. View the existing HMC machine code level
About this task

To determine the existing level of machine code on an HMC, follow these steps:

Procedure

1.
2.

3.

In the Navigation area, click Updates.

In the Work area, view and record the information that appears under the HMC Code Level heading,
including the HMC version, release, maintenance level, build level, and base versions.

Continue with [“Step 3. Back up the managed system's profile data.”

Step 3. Back up the managed system's profile data
About this task

To back up the managed system's profile data, do the following:

Procedure

8.
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In the Navigation area, select Systems Management.

Select Servers.

Select the server and ensure the state is Operating or Standby.

Under Tasks, select Configuration > Manage Partition Data > Backup.
Type a backup file name and record this information.

Click OK.

Repeat these steps for each managed system.

Continue with [“Step 4. Back up HMC data.”|

Step 4. Back up HMC data
About this task

Back up HMC data before installing a new version of HMC software so that previous levels can be
restored in the event of a problem while upgrading the software. Do not use this critical console data
after a successful upgrade to a new version of the HMC software.

Note: To back up to removable media, you will need to have that media available.

To back up HMC data, do the following;:

Procedure

1.

If you plan to back up to media, perform the following steps to format the media:
a. Insert the media into the drive.

b. In the Navigation Pane, select Service Management

c. Select Format Media.
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5.

d. Select the media type.

e. Select the format type.

f. Click OK.

In the Navigation area, select HMC Management.

Select Back up HMC Data. The Back up HMC Data window opens.

Select an archive option. You can back up to media on a local system, a remote system mounted to
the HMC file system (for example, NFES), or send the backup to a remote site using File Transfer
Protocol (FTP).

* To back up to a local system, choose Back up to media on local system and follow the instructions.

* To back up to a mounted remote system, choose Back up to mounted remote system and follow
the instructions.

* To back up to a remote FTP site, choose Send back up critical data to remote site and follow the
instructions.

Continue with [“Step 5. Record the current HMC configuration information.”|

Step 5. Record the current HMC configuration information
About this task

Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record the current HMC configuration, do the following:

Procedure

1.

6.
7.

To view scheduled operations for a managed system or its logical partitions, open Systems
Management. If you want to record scheduled operations for the HMC itself, select HMC
Management and skip to step 3.

Select a managed system and any partitions for which you want to record HMC configuration
information.

In the tasks list, select Schedule Operations. All scheduled operations for the target you selected are
displayed.
Select Sort > By Object.
Select each object and record the following details:
* Object Name
* Schedule date
* Operation Time (displayed in 24-hour format)
* Repetitive (if Yes, perform the following steps):
a. Select View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.
Close the Customize Scheduled Operations window.

Continue with [“Step 6. Record remote command status.”’

Step 6. Record remote command status
About this task

To record remote command status, do the following:
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Procedure

In the navigation area, select HMC Management.

In the tasks list, click Remote Command Execution.

Record whether the Enable remote command execution using the ssh facility check box is selected.
Click Cancel.

5. Continue with [“Step 7. Save upgrade data.”]
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Step 7. Save upgrade data
About this task

You can save the current HMC configuration in a designated disk partition on the HMC or to local
media. Save upgrade data only immediately prior to upgrading your HMC software to a new release.
This action allows you to restore HMC configuration settings after upgrading.

Note: Only one level of backup data is allowed. Each time you save upgrade data, the previous level is
overwritten.

To save upgrade data, do the following:

Procedure
1. In the Navigation area, select HMC Management.

2. In the contents area under Operations, select Save Upgrade Data. The Save Upgrade Data Wizard
opens.

3. Select the media on which you want to save the upgrade data. If you choose to save to removable
media, insert the media now. Click Next.

4. Click Finish.

5. Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of support
before proceeding.

Note: If the save upgrade data task fails, do not continue the upgrade process.
6. Click OK.
7. Continue with [‘Step 8. Upgrade the HMC software.”|

Step 8. Upgrade the HMC software
About this task

To upgrade the HMC software, restart the system with the removable media in the DVD drive.

Procedure
1. Insert the HMC Product Installation media into the DVD drive.
In the Navigation bar, select HMC Management.
In the contents area, select Shutdown or Restart HMC.
Ensure Restart the HMC is selected.
Click OK. The HMC restarts and system information scrolls on the window.
Select Upgrade and click Next.
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Choose from the following options:
 If you have saved upgrade data during the previous task, continue with the next step.

* If you did not save upgrade data previously in this procedure, you must save the upgrade data
now before you continue.

8. Select Upgrade from media and click Next.
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9. Confirm the settings and click Finish.
10. Follow the prompts.

Note:
* If the screen goes blank, press the space bar to view the information.
* The first DVD can take approximately 20 minutes to install.

11. At the login prompt, log in using your user ID and password. The HMC code installation is
complete.

12. Continue with|“Step 9. Verify that the HMC machine code upgrade installed successfully.”|

Step 9. Verify that the HMC machine code upgrade installed successfully
About this task

To verify that the HMC upgrade installed successfully, do the following:

Procedure

1. In the Navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,
build level, and base versions are displayed under the HMC Code Level heading.

2. Verify that the version and release match the update that you installed.

3. If the level of code displayed is not the level that you installed, retry the upgrade task using a new
DVD. If the problem persists, contact your next level of support.

Migrating the machine code on an HMC from Version 6 to Version 7

Learn how to move the machine code on an HMC from Version 6 to Version 7 while maintaining your
HMC configuration data.

About this task
To migrate machine code on an HMC from Version 6 to Version 7, perform Steps 1 through 9.

Important: To migrate to Version 7 Release 0, you must be at a minimum of HMC machine code Version
6 Release 1.2.

Ensure you have met the minimum requirements
Before you begin

To migrate the machine code on an HMC from Version 6 to Version 7, you must first ensure that you
have met the following minimum requirements:

* Your HMC is at level 6.12 or higher. For more information about checking your HMC code level and
release, see ['Determining your HMC machine code version and release” on page 55

* Your system firmware is at its latest level.
* You have performed the network integrity check
* Your HMC hardware supports this upgrade.

Step 1. Obtain the upgrade
About this task

To obtain the upgrade, do the following:

To order the HMC machine code upgrade on DVD-RAM, contact service and support.
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Step 2. View the existing HMC machine code level
About this task

To determine the existing level of machine code on an HMC, follow these steps:

Procedure

1. In the navigation area, click Licensed Internal Code Maintenance folder.

2. Select HMC Code Update.

3. In the Status area, look for the version and release of your HMC machine code.
4

. Record the current version and release.

Important: To upgrade from HMC machine code 6.1.3 to 7.3.4.0, you must first apply a fix. For more
information, see [http://www.ibm.com/eserver /support/fixes,

5. Continue with [“Step 3. Back up the managed system's profile data.”

Step 3. Back up the managed system's profile data
About this task

To back up the managed system's profile data, do the following:

Procedure

1. In the Contents area, select the managed system.

2. From the menu, click Selected > Profile Data > Backup.
3. Type a backup file name and record this information.

4. Click OK.

5. Repeat steps through@ for each managed system.

Step 4. Back up critical console information
About this task

Back up critical console information before installing a new version of HMC software so that previous
levels can be restored in the event of a problem while upgrading the software. Do not use this critical
console data after a successful upgrade to a new version of the HMC software.

Note: If you choose to back up the console data to removable media, you must have that media
available.

To back up critical console information, do the following:

Procedure
1. Choose from the following options:
* If you do not plan to back up to DVD-RAM, continue with the next step.
* If you plan to back up to DVD-RAM, perform the following steps:
a. Insert the DVD-RAM into the drive.
In the navigation area, click Licensed Internal Code Maintenance.
Select HMC Code Update.
Select Format Removable Media.
Select Format DVD-RAM.
f. Click OK.
g. Continue with the next step.
2. Select Back up Critical Console Data.
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3. Select an archive option. You can back up to a DVD in the HMC, a remote system mounted to the
HMC file system (for example, NFS), or send the backup to a remote site using File Transfer Protocol
(FTP).

* To back up to DVD, choose Back up to DVD on local system and follow the instructions.

* To back up to a mounted remote system, choose Backup to mounted remote system and follow the
instructions.

* To back up to a remote FTP site, choose Send backup critical data to remote site and follow the
instructions.

4. Continue with [“Step 5. Record the current HMC configuration information.”|

Step 5. Record the current HMC configuration information
About this task

Before you upgrade to a new version of HMC software, as a precautionary measure, record HMC
configuration information.

To record HMC configuration information, follow these steps:

Procedure

1. To view scheduled operations for a managed system or its logical partitions, open Systems
Management. If you want to record scheduled operations for the HMC itself, select HMC
Management and skip to step 3.

2. Select a managed system and any partitions for which you want to record HMC configuration
information.

3. In the tasks list, select Schedule Operations. All scheduled operations for the target you selected are
displayed.
4. Select Sort > By Obiject.
5. Select each object and record the following details:
¢ Object Name
¢ Schedule date
* Operation Time (displayed in 24-hour format)
* Repetitive (if Yes, perform the following steps):
a. Select View > Schedule Details.
b. Record the interval information.
c. Close the scheduled operations window.
d. Repeat for each scheduled operation.
6. Close the Customize Scheduled Operations window.

7. Continue with [“Step 6. Record remote command status.”|

Step 6. Record remote command status
Procedure

1. In the navigation area, select HMC Management.

2. Select HMC Configuration.

In the tasks list, click Enable/Disable Remote Command Execution.

Record whether the Enable remote command execution using the ssh facility check box is selected.
Click Cancel.

Continue with [“Step 7. Save upgrade data” on page 65/
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Step 7. Save upgrade data
About this task

You can save the current HMC configuration in a designated disk partition on the HMC. Save upgrade
data only immediately prior to upgrading your HMC software to a new release. This action allows you to
restore HMC configuration settings after upgrading.

The upgrade data will be restored automatically during the installation procedure.

Note: Only one level of backup data is allowed. Each time you save upgrade data, the previous level is
overwritten.

Procedure
1. In the navigation area, open the Licensed Internal Code folder.
Select HMC Code Update.
Select Save Upgrade Data.
Select DVD and click Continue.
Insert the DVD media into the drive.
Click Continue to start the task.

Wait for the task to complete. If the Save Upgrade Data task fails, contact your next level of support
before proceeding.
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Note: If the save upgrade data task fails, do not continue the upgrade process.
8. Click OK.
9. Click Cancel.
10. Continue with [“Step 8. Upgrade the HMC software from Version 6 to Version 7."|

Step 8. Upgrade the HMC software from Version 6 to Version 7
Before you begin

About this task
To upgrade the HMC software, restart the system with the DVD-RAM in the DVD drive.

Procedure
1. Insert the HMC Product Installation media.
2. Perform the following steps:
a. From the HMC menu bar, select Console > Exit.
b. Click Exit now.

c. From the logout list, select Reboot Console and click OK. The HMC restarts and system
information scrolls on the window.

3. Select Upgrade and click Next.
4. When the warning is displayed, choose from the following options:
 If you have saved upgrade data during the previous task, continue with the next step.

* If you did not save upgrade data previously in this procedure, you must save the upgrade data
now before you continue.

5. Select Upgrade from media and click Next.
6. Confirm the settings and click Finish.
7. Follow the prompts.
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10.
11.
12.

Note:

* If the screen goes blank, press the space bar to view the information.

* The first DVD can take approximately 20 minutes to install.

When prompted, remove the first media and then insert the second media.

Select 1. Install additional software from media and press Enter. Press any key to confirm the
installation. The HMC will display status messages as it installs the packages.

Click Log on and launch the Hardware Management Console web application.
Log in to the HMC interface.
Continue with [“Step 9. Verify that the HMC machine code upgrade installed successfully.”|

Step 9. Verify that the HMC machine code upgrade installed successfully
Procedure

1.

In the Navigation area, click Updates. In the Work area, the HMC version, release, maintenance level,
build level, and base versions are displayed under the HMC Code Level heading.

Verify that the version and release match the update that you installed.

If the level of code displayed is not the level that you installed, retry the upgrade task using a new
DVD. If the problem persists, contact your next level of support.

Step 10. Obtain an update package
About this task

To order an HMC machine code update package, contact service and support.

Step 11. Reschedule operations for this HMC
About this task

When you upgrade the HMC, you must manually reschedule the operations you scheduled using the
previous HMC version.

Procedure

1.
2.
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In the Navigation area, click HMC Management.
In the Work area, click Schedule Operations.
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Notices

This information was developed for products and services offered in the U.S.A.

The manufacturer may not offer the products, services, or features discussed in this document in other
countries. Consult the manufacturer's representative for information on the products and services
currently available in your area. Any reference to the manufacturer's product, program, or service is not
intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any intellectual property right of the
manufacturer may be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any product, program, or service.

The manufacturer may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to the manufacturer.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: THIS PUBLICATION IS PROVIDED “AS IS” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
The manufacturer may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to websites not owned by the manufacturer are provided for
convenience only and do not in any manner serve as an endorsement of those websites. The materials at
those websites are not part of the materials for this product and use of those websites is at your own risk.

The manufacturer may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning products not produced by this manufacturer was obtained from the suppliers of
those products, their published announcements or other publicly available sources. This manufacturer has
not tested those products and cannot confirm the accuracy of performance, compatibility or any other
claims related to products not produced by this manufacturer. Questions on the capabilities of products
not produced by this manufacturer should be addressed to the suppliers of those products.

All statements regarding the manufacturer's future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

The manufacturer's prices shown are the manufacturer's suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

The drawings and specifications contained herein shall not be reproduced in whole or in part without the
written permission of the manufacturer.

The manufacturer has prepared this information for use with the specific machines indicated. The
manufacturer makes no representations that it is suitable for any other purpose.

The manufacturer's computer systems contain mechanisms designed to reduce the possibility of
undetected data corruption or loss. This risk, however, cannot be eliminated. Users who experience
unplanned outages, system failures, power fluctuations or outages, or component failures must verify the
accuracy of operations performed and data saved or transmitted by the system at or near the time of the
outage or failure. In addition, users must establish procedures to ensure that there is independent data
verification before relying on such data in sensitive or critical operations. Users should periodically check
the manufacturer's support websites for updated information and fixes applicable to the system and
related software.

Ethernet connection usage restriction

This product is not intended to be connected directly or indirectly by any means whatsoever to interfaces
of public telecommunications networks.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
[Copyright and trademark information| at www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Other product and service names might be trademarks of IBM or other companies.

Electronic emission notices

When attaching a monitor to the equipment, you must use the designated monitor cable and any
interference suppression devices supplied with the monitor.

Class A Notices
The following Class A statements apply to the servers.
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Federal Communications Commission (FCC) statement

Note: This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to meet FCC emission
limits. IBM is not responsible for any radio or television interference caused by using other than
recommended cables and connectors or by unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the user's authority to operate the equipment.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Industry Canada Compliance Statement

This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité a la réglementation d'Industrie Canada

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.
European Community Compliance Statement

This product is in conformity with the protection requirements of EU Council Directive 2004/108/EC on
the approximation of the laws of the Member States relating to electromagnetic compatibility. IBM cannot
accept responsibility for any failure to satisfy the protection requirements resulting from a
non-recommended modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A Information Technology
Equipment according to European Standard EN 55022. The limits for Class A equipment were derived for
commercial and industrial environments to provide reasonable protection against interference with
licensed communication equipment.

European Community contact:

IBM Deutschland GmbH

Technical Regulations, Department M456
IBM-Allee 1, 71139 Ehningen, Germany
Tele: +49 7032 15-2937

email: tjahn@de.ibm.com

Warning: This is a Class A product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.
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VCCI Statement - Japan
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The following is a summary of the VCCI Japanese statement in the box above:

This is a Class A product based on the standard of the VCCI Council. If this equipment is used in a
domestic environment, radio interference may occur, in which case, the user may be required to take
corrective actions.

Japanese Electronics and Information Technology Industries Association (JEITA)
Confirmed Harmonics Guideline (products less than or equal to 20 A per phase)

CHEE b R e N= T

Japanese Electronics and Information Technology Industries Association (JEITA)
Confirmed Harmonics Guideline with Modifications (products greater than 20 A per
phase)
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Electromagnetic Interference (EMI) Statement - People's Republic of China
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Declaration: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may need to perform practical action.
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Electromagnetic Interference (EMI) Statement - Taiwan
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The following is a summary of the EMI Taiwan statement above.

Warning: This is a Class A product. In a domestic environment this product may cause radio interference
in which case the user will be required to take adequate measures.

Electromagnetic Interference (EMI) Statement - Korea
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Germany Compliance Statement

Deutschsprachiger EU Hinweis: Hinweis fiir Gerite der Klasse A EU-Richtlinie zur
Elektromagnetischen Vertraglichkeit

Dieses Produkt entspricht den Schutzanforderungen der EU-Richtlinie 2004/108/EG zur Angleichung der
Rechtsvorschriften iiber die elektromagnetische Vertrdglichkeit in den EU-Mitgliedsstaaten und hélt die
Grenzwerte der EN 55022 Klasse A ein.

Um dieses sicherzustellen, sind die Gerate wie in den Handbtichern beschrieben zu installieren und zu
betreiben. Des Weiteren diirfen auch nur von der IBM empfohlene Kabel angeschlossen werden. IBM
iibernimmt keine Verantwortung fiir die Einhaltung der Schutzanforderungen, wenn das Produkt ohne
Zustimmung von IBM verdndert bzw. wenn Erweiterungskomponenten von Fremdherstellern ohne
Empfehlung von IBM gesteckt/eingebaut werden.

EN 55022 Klasse A Gerédte miissen mit folgendem Warnhinweis versehen werden:

"Warnung: Dieses ist eine Einrichtung der Klasse A. Diese Einrichtung kann im Wohnbereich
Funk-Stérungen verursachen; in diesem Fall kann vom Betreiber verlangt werden, angemessene
Mafinahmen zu ergreifen und dafiir aufzukommen."

Deutschland: Einhaltung des Gesetzes iiber die elektromagnetische Vertraglichkeit von Geriten

Dieses Produkt entspricht dem “Gesetz iiber die elektromagnetische Vertraglichkeit von Gerdten
(EMVG)”“. Dies ist die Umsetzung der EU-Richtlinie 2004/108/EG in der Bundesrepublik Deutschland.
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Zulassungsbescheinigung laut dem Deutschen Gesetz iiber die elektromagnetische Vertraglichkeit von
Geriten (EMVG) (bzw. der EMC EG Richtlinie 2004/108/EG) fiir Gerite der Klasse A

Dieses Gerit ist berechtigt, in Ubereinstimmung mit dem Deutschen EMVG das EG-Konformititszeichen
- CE - zu fiihren.

Verantwortlich fiir die Einhaltung der EMV Vorschriften ist der Hersteller:
International Business Machines Corp.

New Orchard Road

Armonk, New York 10504

Tel: 914-499-1900

Der verantwortliche Ansprechpartner des Herstellers in der EU ist:
IBM Deutschland GmbH

Technical Regulations, Abteilung M456

IBM-Allee 1, 71139 Ehningen, Germany

Tel: +49 7032 15-2937

email: tjahn@de.ibm.com

Generelle Informationen:
Das Gerit erfiillt die Schutzanforderungen nach EN 55024 und EN 55022 Klasse A.

Electromagnetic Interference (EMI) Statement - Russia

BHUUMAHWE! HacTtosiwee nagenue oTHocUTCS K Kraccy A.
B XMnbIX NOMELLLEHUSIX OHO MOXeT co3faBaTtb
pagnonoMexu, AN CHUKEHUS KOTOPbIX HEODXOANMBI
OOMNOMHUTENbHbIE MEpPbI

Terms and conditions

Permissions for the use of these publications are granted subject to the following terms and conditions.
Applicability: These terms and conditions are in addition to any terms of use for the IBM website.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Rights: Except as expressly granted in this permission, no other permissions, licenses or rights are
granted, either express or implied, to the Publications or any information, data, software or other
intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.
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You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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